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Introduccion

Gracias por elegir a Medtronic Diabetes como aliado para que usted y sus pacientes tengan
un mejor control del tratamiento de la diabetes. Creemos que se beneficiarad de la tecnologia
de vanguardia del programa CarelLink® Pro y de la sencilla interfaz de usuario basada en
menus.

CareLink Pro permite adquirir los datos de diagndstico y tratamiento del paciente asi como
guardarlos y crear informes sobre los mismos. También puede utilizarlo para acceder a los
datos de glucosa de la bomba, del medidor y del sensor que los pacientes han transferido a
CareLink® Personal, un programa para la gestion del tratamiento basado en web que funciona
con CarelLink Pro.

Caracteristicas

CarelLink Pro es un programa para la gestién del tratamiento de la diabetes para ordenadores
personales (PC). Incluye las siguientes caracteristicas:

«  Pueden crearse registros de pacientes para almacenar datos obtenidos del dispositivo de un
paciente asi como datos de la terapia de su cuenta de CarelLink Personal.

+  Los datos de las bombas de insulina, de los monitores y de los medidores de glucosa pueden

enviarse al progama, almacenarse y después utilizarse para generar informes.

«  Opcionalmente, se comunica con el sistema CarelLink Personal, permitiendo el acceso a los
datos del dispositivo que los pacientes han almacenado ahi. Esto es ideal para crear informes
actualizados entre las visitas al consultorio, y puede hacer innecesario leer los datos del

dispositivo durante las visitas.

«  Pueden crearse diferentes informes de la terapia a partir de los datos del dispositivo
almacenados en el registro del paciente. Los informes ayudan a responder a preguntas del
tratamiento tales como el cumplimiento por parte del paciente, los patrones y las

excepciones.

«  El progama le avisa si hay actualizaciones del software disponibles para descargar e instalar.
Esto le garantiza el acceso a las caracteristicas mas recientes.
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« La funcién Guide Me (Guiame) es una ayuda para los usuarios que utilizan CarelLink Pro por

primera vez. Proporciona sugerencias y consejos sobre las tareas que estan realizando.

«  El programa dispone de un sistema de ayuda integrado que proporciona informacién sobre
areas especificas de interés.
Pregunta

«  Carelink Pro puede protegerse con contrasena.

« La transmision de los datos de pacientes desde CarelLink Personal se encripta mediante SSL
(Secure Sockets Layer, capa de proteccion segura), un estandar de la industria.
Documentos relacionados

Todos los documentos de Medtronic MiniMed indicados a continuacién contienen

informacién especifica del dispositivo que no se trata en detalle en esta guia del usuario.

NOTA: Para los medidores de otras companias, véanse las instrucciones incluidas por el
fabricante con el medidor.

+  Guia del usuario de la bomba de insulina Paradigm
«  Guia del usuario del monitor Guardian REAL-Time

«  Guia del usuario de las caracteristicas del sensor

«  Guia del usuario de ComLink

«  Guia del usuario del dispositivo USB CareLink

Asistencia técnica

Si necesita mas ayuda relativa a este programa, péngase en contacto con el representante
local. Si desea obtener informacion sobre la lista de contactos internacionales, acuda a la

siguiente pagina:

http://www.medtronicdiabetes.com/help/contact/locations.html

Dispositivos compatibles

CareLink Pro obtiene datos de los dispositivos indicados a continuacién.

NOTA: Es posible que algunos de los dispositivos compatibles con este programa de
software no estén disponibles en todos los paises en los que el programa estd aprobado

para su uso.
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Bombas de Medtronic MiniMed:

CSS-7100
CSS-7100K

Monitores Guardian REAL-Time:

. . X . . Bayer CONTOUR® LINK
Dispositivos asociados compatibles con Medtronic . .
Diabetes: Monitor de glucosa en sangre BD Paradigm

Link®

. Ascensia BREEZE®
Bayer: . BREEZE® 2
. CONTOUR®

. Ascensia® DEX®

. Ascensia® DEX® 2

. Ascensia® DEXTER-Z® Il
. Glucometer® DEXTER-Z®
. Ascensia® ESPRIT® 2

. Glucometer® ESPRIT®

. Glucometer® ESPRIT® 2

Familia Bayer Ascensia® DEX®, que incluye los siguientes
medidores compatibles:
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Abbott:

Com-Station

Medidor de glucosa en sangre Paradigm Link®

Cable de comunicacion de datos

FreeStyle®

FreeStyle® Lite®
FreeStyle® Freedom®
FreeStyle® Freedom Lite®
Precision Xtra™
TheraSense FreeStyle®
FreeStyle® Flash®
FreeStyle® Papillon™ mini
FreeStyle® Mini®

Optium Xceed™
Precision Xceed™

Para uso con la bomba Medtronic MiniMed 508.
(Véanse en la guia del usuario de Com-Station los
detalles sobre los requisitos de hardware).

Para uso con la bomba MiniMed Paradigm vy el
monitor Guardian REAL-Time. (Véanse en la guia
del usuario del medidor de glucosa en sangre
Paradigm Link® los detalles sobre los requisitos de
hardware.)

Para uso con medidores de glucosa de otros
fabricantes. Cada fabricante de medidores
suministra un cable de comunicacion de datos.

Nota: Si un fabricante de medidores proporciona
un cable USB en lugar de un cable en serie para
cargar datos, debe instalar el controlador del
programa proporcionado por el fabricante.

Ademés, compruebe con el fabricante de
medidores si el controlador USB es compatible
con su sistema operativo. Es posible que algunos
controladores USB no estén disponibles para
sistemas operativos de 64 bits.

Dispositivos equivalentes

Al anadir un dispositivo al programa, hay que seleccionar la marca y el modelo en una lista.

Si no aparecen en la lista la marca y el modelo de un dispositivo, consulte la siguiente tabla

para encontrar uno equivalente.
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. Bayer Ascensia® DEX® 2

. Bayer Ascensia® DEXTER-Z°® I
. Bayer Glucometer® DEXTER-Z®
. Bayer Ascensia® ESPRIT® 2

. Bayer Glucometer® ESPRIT®

. Bayer Glucometer® ESPRIT® 2

Bayer Ascensia® DEX®

Bayer Glucometer ELITE® XL Bayer Ascensia ELITE™
Precision Xceed™ Optium Xceed™
Pedidos

Para realizar un pedido de productos de Medtronic Diabetes, contacte con su representante
local. Si desea obtener informacién sobre la lista de contactos internacionales, acuda a la
siguiente pdgina:

http://www.medtronicdiabetes.com/help/contact/locations.html

NOTA: Los medidores pueden solicitarse a las respectivas companias.

Como utilizar esta guia

NOTA: Esta guia del usuario muestra ejemplos de las pantallas del programa. Las
pantallas del progama real pueden ser ligeramente diferentes.

Consulte el glosario para ver las definiciones de términos y funciones. En la tabla siguiente se

definen las convenciones empleadas en esta guia.

Pulsar el botén izquierdo del ratén sobre un

Hacer clic . :
objeto de la pantalla para seleccionarlo.

Pulsar dos veces el botén izquierdo del ratén

ity @il e sobre un objeto de la pantalla para abrirlo.

Pulsar el botén derecho del ratén sobre un objeto

Hacer clic con el boton derecho . ,
de la pantalla para abrir otra ventana o menu.

Utilizado para un botén, nombre de pantalla,
nombre de campo u opcidon de menu. Por
ejemplo: Patient (Paciente)> New Patient (Nuevo
paciente)

Texto en negrita

Proporciona informacion adicional para un
procedimiento o paso.

NOTA:

CareLink Pro Guia del usuario  Introduccién 5


http://www.medtronicdiabetes.com/help/contact/locations.html

) Avisa de un peligro que, de no evitarse, podria
PRECAUCION: causar dafnos leves o moderados al programa o al
equipo.

Le avisa de un peligro potencial que, de no
evitarse, podria causar lesiones graves o incluso la
ADVERTENCIA: muerte. Puede describir también posibles
reacciones adversas graves y peligros de
seguridad.

Seguridad del usuario

Indicaciones de uso

CarelLink Pro esta destinado a utilizarse como herramienta para facilitar la gestion de la
diabetes. La finalidad de este programa es recoger la informaciéon transmitida por bombas de
insulina, medidores de glucosa y sistemas de monitorizacién continua de glucosa y
transformarla en informes de CareLink Pro. Los informes proporcionan informacién que puede
utilizarse para identificar tendencias y hacer un seguimiento de las actividades cotidianas,
como la cantidad de carbohidratos ingeridos, las horas de las comidas, la administracion de
insulina y las lecturas de glucosa.

Advertencias

«  Este progama estad destinado a ser utilizado por un equipo médico familiarizado con la
gestion de la diabetes.

+  Los resultados del progama no estan pensados para establecer un dictamen médico y no
deben utilizarse con dicho objetivo.

«  Este producto sélo debe utilizarse con los dispositivos compatibles indicados en este
documento. (Consulte Dispositivos compatibles en la pdgina 2).

«  Debe aconsejarse a los pacientes que controlen sus niveles de glucosa en sangre al menos 4
- 6 veces al dia.

«  Debe indicarse a los pacientes que no realicen cambios en su tratamiento sin consultar antes
a su equipo médico.

« Debe indicarse a los pacientes que las decisiones terapéuticas que tomen deben basarse en
las instrucciones del equipo médico y en los resultados del medidor de glucosa en sangre y
no en los resultados del sensor de glucosa.

Contraindicaciones

Este programa no debe utilizarse con dispositivos no mencionados en el apartado Dispositivos
compatibles en la pdgina 2. Tampoco debe utilizarse este producto para el tratamiento de
enfermedades distintas de la diabetes.

Antes de abrir este programa, cierre los siguientes programas que estén ejecutandose en ese
momento en el ordenador:

«  Programa de software CGMS® System Solutions™ (7310)
«  Programa Solutions’ Pumps & Meters (7311)
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Programa Guardian® Solutions® software (7315)
ParadigmPAL™ (7330)
Programa CarelLink® Personal (7333)

Programa Solutions” para CGMS"iPro (7319)
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Como comenzar

La siguiente informacién le guiara para iniciar el programa CareLink Pro, abrir y cerrar
registros de pacientes y establecer las preferencias que desee aplicar a todos los pacientes del
programa.

Antes de empezar

Si esta es la primera vez que utiliza el programa CarelLink Pro, debe asegurarse de configurar
las preferencias generales (consulte el apartado Preferencias generales en la pdgina 13). Estas
preferencias determinan como se muestran ciertos elementos en el programa y en los
informes, y como desea que el programa se comunique con internet.

Las preferencias pueden configurarse en cualquier momento. Si lo desea, puede esperar a
estar familiarizado con el programa CareLink Pro para configurar las demas preferencias.

Tareas principales del programa

En la tabla siguiente se resumen las tareas principales que hay que realizar al configurar y
utilizar por primera vez CarelLink Pro. También se indica en qué parte de esta guia del usuario

se comenta cada tarea.

Familiaricese con la interfaz del usuario del programa

CareLink Pro. Navegacion por el programa en la pdgina 9

Definir las opciones globales del programa que utilizard | Configuracién de las preferencias del sistema en la

el centro sanitario. pdgina 13

Crear perfiles para cada paciente. Cémo anadir nuevos perfiles en la pdgina 22
Conectarse a las cuentas de CarelLink Personal de sus Conexion al programa Carelink Personal en la
pacientes. pdgina 23

Anadir la bomba y los medidores de los pacientes' a sus Cémo afiadir un dispositivo en la pdgina 30

perfiles.
Leer los datos de la bomba y de los medidores de los Cémo leer los datos de un dispositivo en la
pacientes. pdgina 36
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Configurar y generar informes para cada paciente. Crear informes en la pdgina 40

Hacer periddicamente una copia de seguridad de la Hacer una copia de seguridad de la base de datos en
base de datos el programa CareLink Pro. la pdgina 52

Actualizar el programa Carelink Pro. Actualizaciones del software en la pdgina 50

Navegacion por el programa

Antes de trabajar con el programa Carelink Pro, debe familiarizarse con la interfaz de usuario.
La interfaz del usuario incluye menus, una barra de herramientas, una barra de navegacion,
areas de trabajo y la ventana Guide Me (Guiame).

Abrir el programa CareLink Pro

1 Haga doble clic en el icono de CareLink Pro H en el escritorio de su equipo, o seleccione
? =
Medtronic CareLink Pro en la lista de programas del menu Inicio de Windows.
Si su hospital requiere que introduzca una contrasefa, se muestra la pantalla de inicio de
sesion.

a. Escriba la contrasena en el campo Password (Contrasefa).

NOTA: La necesidad de introducir una contrasena es una funcion opcional que se
configura durante el proceso de instalacion.

b. Haga clic en LOGIN (Inicio de sesién).
Aparece la pantalla de inicio.

2 Para iniciar un nuevo registro de cliente, haga clic en New Patient (Nuevo paciente). Para
abrir un registro de cliente de una lista de pacientes del sistema, haga clic en Open Patient
(Abrir paciente).

Areas de trabajo

Si tiene abierto un registro de paciente, puede hacer clic en uno de los botones de la barra de
navegacion para mostrar el drea de trabajo correspondiente. Utilice estas areas de trabajo
para introducir o seleccionar informacion para realizar tareas de Carelink Pro para ese
paciente.
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Perfil: le permite mantener almacenada
— informacion del paciente tal como el nombre
=] y la fecha de nacimiento. Esta area de trabajo
- le permite también vincularse con la cuenta
personal de Carelink de un paciente.

[ ] Dispositivos: le permite almacenar
ﬂ informacion necesaria para leer los
P—— dispositivos de un paciente.

o | Informes: le permite seleccionar pardmetros
@ y elegir los informes que desee generar para
Bl el paciente.

Hasta que afade y guarda un perfil para un cliente, sélo el area de trabajo del perfil esta
accesible para ese paciente. Hasta que se agregan los dispositivos para un paciente, sélo las
areas de trabajo Perfil y Dispositivos estan accesibles para ese paciente.

Barra de herramientas

La barra de herramientas de CarelLink Pro proporciona acceso rapido a funciones utilizadas

frecuentemente. La barra de herramientas contiene los botones siguientes.

Abre un area de trabajo Perfil,

% Botdn Add Patient (Aiadir de tal modo que puede agregar
L paciente) un nuevo registro del paciente
al sistema.

Abre la tabla Patient Lookup
(Busqueda de pacientes), en la
que puede elegir un registro de
paciente existente para ver.

Open Patient (Abrir paciente)

Muestra u oculta la ventana
Guide Me (Guiame). Haga clic
para ver sugerencias
contextuales del programa.

? Guide Me (Guiame)

Fichas de paciente

Cuando se abre un registro de paciente, se muestra una ficha en la barra de herramientas con
el nombre del paciente. Si una ficha estd activa, eso significa que el registro del paciente y el
area de trabajo estan activos y que puede realizar tareas de CarelLink Pro para ese paciente.

=& Medtronic Carelink® Pro

File Wiew Tools Language Help | @ Q,‘ ?

PATIENT, SAMPLE [ || New Patient [

Para activar el registro de un paciente de forma que pueda trabajar con él, haga clic en la ficha
de dicho paciente. Para cerrar el registro de un paciente, haga clic en el botén Close (Cerrar)
E de la ficha.
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La funcion Guide Me (Guiame)

La funcién Guide Me (Guiame) se proporciona a través de CareLink Pro. Abre una ventana con

sugerencias y consejos contextuales para acciones que podria realizar en la parte del

programa que esta activa. Las ventanas de la funcién Guide Me (Guiame) también pueden

incluir vinculos >>learn more (mas informacién). Al hacer clic en estos vinculos, se accede a la

seccion relevante de la ayuda en linea que muestra informacién mas detallada. La funcién

Guide Me (Guiame) esta activada de manera predeterminada. Sin embargo, puede

desactivarla en cualquier momento.

Start up window

IF you choose ko add & new patient, a

blank Frofie warkspace is daplaved. IF
you choose o open an exisking patien:
reczed, the Cpen Fabent vandow is

displayzd,

#¥ learmn mare

What next?

T wou ae adding a new patienc, yoo wil
complece Hhelr prafile.

#¥ learn nre

If wou e Opening an exsting patiens,
yal can!

|3

Activacion y desactivacion de la funcién Guide Me (Guiame)

Para activar o desactivar esta funcién, realice una de las siguientes acciones:

+  Haga clic en el botén Guide Me (Guiame). F

«  Seleccione Help (Ayuda) > Guide Me (Guiame).

Apertura de registros de pacientes

Pueden abrirse un maximo de seis registros de pacientes al mismo tiempo. Si no ha creado

todavia ningun perfil de paciente, consulte el apartado Cémo anadir nuevos perfiles en la

pdgina 22.

CareLink Pro Guia del usuario
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1 Seleccione File > Open Patient (Archivo > Abrir paciente) o haga clic en el botén Open

Patient (Abrir paciente). & Aparece una lista de pacientes similar a la que aparece aqui a

continuacion.

“L Open Patient
Fimedl & Palienk CLEAR
| FE A R T T
Diate of
Firsk Mame Last Name Barth Paki=nt 10

SAMPLE PATENT 121071975 1]

gSunph Ptizrk 1117193 100001

| sanple Pizrkd e 100002

MEW PATIENT | MPEM CANCEL

NOTA: Si recibe un mensaje que indica que tiene demasiados registros de pacientes
abiertos, haga clic en OK (Aceptar), cierre un registro y continte.

2 Localice el nombre del paciente en la lista escribiendo parte de su nombre o su nombre
completo en el campo Find a Patient (Buscar paciente). Si el listado de pacientes aparece,
haga clic en OPEN (Abrir), doble clic en el listado o pulse INTRO. También puede desplazarse
por la lista utilizando las flechas arriba y abajo del teclado.

Se muestra el area de trabajo Devices (Dispositivos) (si no se han anadido todavia
dispositivos) o Reports (Informes) del paciente.

3 Para consultar el drea de trabajo Perfil del paciente, haga clic en el botén Profile (Perfil)

@ en la barra de navegacion.

PR |

Cierre de registros de pacientes

1 Asegurese de que esté activo el registro de paciente que desee cerrar (la ficha aparece
resaltada).

2 Realice una de las acciones siguientes:
a. Seleccione File > Close Patient (Archivo > Cerrar paciente).
b. Haga clic en el boton Close (Cerrar) E de la ficha del paciente.
c. Pulse Ctrl+F4.
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Configuracion de las preferencias del sistema

Estas preferencias se aplican a todos los pacientes del programa. Las preferencias aplicables
Unicamente a pacientes individuales se describen en el apartado Comprobar la configuracion
de los informes en la pdgina 43.

Las preferencias se presentan en los siguientes grupos:

«  General (Generales)
- Unidades de glucosa
- Unidades de carbohidratos
- Comunicaciones
- Resolucion de problemas

- Patient Profile (Perfil del paciente)

- Permite seleccionar y organizar los campos de datos en los perfiles de pacientes.

«  Patient Lookup (Busqueda de pacientes)
- Permite modificar y cambiar el orden de los campos mostrados cuando se elige Open
Patient (Abrir paciente) para ver una lista de pacientes.

«  Report Generation (Generacion de informes)
- Permite seleccionar los campos de datos que se desee mostrar al seleccionar los datos
de los informes Daily Detail (Detalles diarios) en la tabla de datos.

Preferencias generales

Utilice la ficha General para definir cdmo muestra el software determinados tipos de
informacién y establecer las preferencias de comunicacién externas.

1 Si no estd ya activa, haga clic en la ficha General.

2 Seleccione Tools > Options (Herramientas > Opciones). Aparece la ventana mostrada a
continuacion.

ok hobed prions for comewrcations sl Unde of meskrmert 33 e s

[rmayr———. [ r———
2 vy el (5] g

§5 5 graves e wgual ko § Techangs

Uhast (dumes et sl

Drrervies A epariy | Aastrematic alby theek fre noft ware wpelabes
] Tomwtt Pl o B alirags o e Sieien = .
I Crerilay T L e B ]
Charge el ifuct S nast e lwirch the e ks
(TR —r—

[ Sarve o snapebest wrich every dewiie peak prad sddtinnsl datsbom
i d gy

(rormae tima regured 52 read’ oms devost |
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Haga clic para seleccionar el botén de opcién del valor que desee:

- Unidades de glucosa: mg/dL o mmol/L.

- Carbohydrate Units (Unidades de carbohidratos): grams (gramos) o Exchanges
(Raciones).

a. Si ha seleccionado Exchanges (Raciones) para Carbohydrate Units (Unidades de
carbohidratos), escriba el nimero adecuado en el campo gramos igual a 1 racién.

Haga clic para seleccionar o desactivar la casilla de verificaciéon en la secciéon Chart Options >
Overview Report. Si se activa la casilla de verificacion, la aplicacién conectara las lecturas de
glucosa de la tabla de Meter Glucose Overlay (Revestimiento del medidor de glucosa) con las
lineas. (Esta es una tabla que aparece en el informe Sensor and Meter Overview Report
[Informe de resumen del medidor y del sensor]).

Para las siguientes preferencias del cuadro Communications (Comunicaciones), haga clic para
seleccionar la casilla de verificacién (activar) o para dejar vacia la casilla (desactivar):

NOTA: Aseglrese de seqguir las instrucciones de su centro o del departamento
informdtico cuando configure las preferencias de comunicaciones.

- Automatically check for software updates (Comprobar automaticamente la
disponibilidad de actualizaciones del software): si se selecciona esta opcién, se
enviard un aviso a cada sistema que esté ejecutando el programa CarelLink Pro siempre
que haya disponible una actualizacién del programa. El usuario activo tendra la
oportunidad de descargar e instalar las actualizaciones. Para evitar que suceda esto e
instaurar una distribucion controlada de las actualizaciones del software, desactive esta
casilla de verificacion.

- Synchronize with Medtronic CareLink® Personal (Sincronizar con CareLink
Personal): si desea que el programa sincronice automaticamente los datos de CareLink
Personal de sus pacientes cada vez que abra su perfil, seleccione la casilla de verificaciéon.
Si deja vacia esta casilla de verificacion, tendra que sincronizar manualmente los datos
del programa CarelLink Personal para cada paciente.

Haga clic para seleccionar la casilla de verificacion o para dejarla vacia en la seccién
Troubleshooting (Resolucion de problemas). Si la casilla de verificacién esta seleccionada, la
aplicacién guarda un registro de lecturas del dipositivo para resolucién de problemas.

Haga clic en OK (Aceptar) para guardar las preferencias generales.

Preferencias de los perfiles de pacientes

Esta es una configuracién global que define el contenido de los perfiles. Puede personalizar

los campos del area de trabajo Perfil para incluir la informacién mas importante para su

centro. Puede agregar o quitar campos, crear sus propios campos personalizados y determinar

el orden en el que aparecerdn los campos en la ventana.

1

Seleccione Tools > Options (Herramientas > Opciones).
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Haga clic en la ficha Patient Profile (Perfil del paciente)

continuacion.

SL Upllans
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CANCEL

NOTA: Utilice las casillas de verificacion para elegir los campos que desee incluir en

el perfil. Utilice las flechas arriba y abajo para ordenar los campos.

Como elegir campos de datos

1

Utilice las casillas de verificacién para anadir los campos que desee.

NOTA: Los campos First Name (Nombre) y Last Name (Apellidos) no pueden

eliminarse.

Para eliminar un campo del perfil, deje vacia su casilla de verificacion.

Para hacer que un campo sea obligatorio, seleccione la casilla de verificacién

correspondiente en la columna Required (Obligatorio). Los campos obligatorios deben

rellenarse para poder crear un perfil.

Coémo anadir un campo personalizado

1
2

Seleccione la casilla de verificacién situada a la izquierda de un campo personalizado vacio.

Introduzca el nombre del campo (por ejemplo, Contacto para urgencias). Este es el nombre

del campo que aparecera en el perfil del paciente.

Para hacer que el campo sea obligatorio, seleccione la casilla de verificacién correspondiente

en la columna Required (Obligatorio).

CareLink Pro Guia del usuario  Cémo comenzar 15



NOTA: Para eliminar un campo personalizado del perfil, deje vacia la casilla de
verificacion situada junto al campo en cuestion.

Como cambiar el orden de los campos de datos

. . . . = -
Seleccione el campo que desee mover y haga clic en las flechas arriba o abajo | _| para

moverlo. (Las flechas situadas en la parte superior e inferior mueven un campo hasta el

comienzo o el final de la lista).

Finalizacion de las preferencias de los perfiles de pacientes

Cuando la lista Field Order (Orden de campos) tenga todos los campos que desea en el orden
correcto, haga clic en OK (Aceptar).

Los perfiles de pacientes ya tienen los campos que acaba de seleccionar, en el orden
seleccionado.

Preferencias de busqueda de pacientes

La tabla Patient Lookup (Busqueda de pacientes) se utiliza para buscar y abrir un registro de
paciente. La tabla incluye a cada paciente de su base de datos y proporciona informacion de
identificacion del perfil del paciente. Tiene la opcion de personalizar la informacién que se
muestra en esta tabla y el orden en que aparecen las columnas. Para personalizar la tabla
Patient Lookup (Busqueda de pacientes), realice los siguientes pasos:

1 Seleccione Tools > Options (Herramientas > Opciones).

2 Haga clic en la ficha Patient Lookup (Busqueda de pacientes). Aparece la ventana mostrada
a continuacion.

L Opliens
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NOTA: Utilice las casillas de verificacion para elegir los datos que desee en la tabla
Patient Lookup (Busqueda de pacientes). Utilice las flechas arriba y abajo para
ordenar las columnas.

Como elegir los datos que se desea mostrar

Utilice las casillas de verificacion para seleccionar el tipo de datos que desea mostrar o para
eliminar los datos que no desea mostrar en la tabla Patient Lookup (Busqueda de pacientes).

Coémo cambiar el orden de las columnas
Para cambiar el orden de las columnas en la tabla Patient Lookup (Busqueda de pacientes),

. : . .=
seleccione la columna que desee mover y haga clic en las flechas arriba o abajo. (Las

& X
flechas situadas en la parte superior e inferior mueven una columna de datos hasta el
comienzo o el final de la lista).

La columna de datos situada en la parte superior de la lista Column Display Order (Orden de
presentacion de las columnas) aparecera en la primera columna de la tabla Patient Lookup
(Busqueda de pacientes). La columna de datos situada en la parte inferior aparecera en la
ultima columna de la tabla.

Finalizacion de las preferencias de busqueda de pacientes

Cuando la lista Column Display Order (Orden de presentacién de las columnas) tenga todos

los datos que desea en el orden correcto, haga clic en OK (Aceptar).

La tabla Patient Lookup (Busqueda de pacientes) tendrd ahora los datos y el orden de
columnas que acaba de seleccionar.

Preferencias para la generaciéon de informes

La tabla de datos aparece en la ventana Select and Generate Reports (Seleccionar y generar
informes). Esta tabla se utiliza durante el informe. Contiene informacién diaria derivada de
los dispositivos del paciente y, si procede, su cuenta del programa Carelink Personal. Los
datos proporcionados en esta tabla le ayudan a determinar los dias en los que se necesita
un informe de detalles diarios. También ayuda a decidir cudl de los otros informes deberia
ejecutar.

Su centro puede personalizar los datos mostrados en esta tabla, incluyendo el orden en que
se presentan, para reflejar aquellos que son mas importantes para su consultorio.

NOTA: Para ver como se aplican estas preferencias a la tabla de datos durante la creacion
de informes, consulte el apartado Seleccionar los tipos de informes y las fechas de inclusion
en la pdgina 45.

1 Seleccione Tools > Options (Herramientas > Opciones).
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mostrada a continuacion.
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Como elegir los datos que se desea mostrar

Utilice las casillas de verificacion para seleccionar el tipo de datos que desea mostrar o para

eliminar los datos que no desea mostrar en la tabla de datos.

La siguiente informacién esta disponible para inclusion en la tabla de datos.

Ne of Meter Readings (N° de lecturas del medidor)

La cantidad de lecturas de la fecha especificada que
los dispositivos incluidos han grabado.

Meter Readings Average (Promedio de lecturas del
medidor)

El promedio de las lecturas de glucosa grabado por
los dispositivos incluidos.

Sensor Duration (Duracion del sensor)

La cantidad de tiempo dentro de la fecha
especificada para la que se grabd la fecha del
sensor. Los valores -- (ninguno), 0:05 - 24:00.

Sensor Average (Promedio del sensor)

El promedio de lecturas del sensor grabado en la
fecha especificada.

Highest Reading (Lectura mds alta)

La lectura de glucosa mas alta (derivada de un
sensor o medidor) para la fecha.

Lowest Reading (Lectura mas baja)

La lectura de glucosa mas baja (derivada de un
sensor o medidor) para la fecha.

Avg AUC Below Target (AUC prom. por debajo de
objetivo)

Area bajo la curva prom. por debajo del intervalo
del objetivo del paciente.

Avg AUC Above Target (AUC prom. por encima de
objetivo)

Area bajo la curva prom. por encima del intervalo
del objetivo del paciente.
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La suma de todas las cantidades de carbohidratos
(redondeado al préximo gramo o al intercambio 0,1
mas proximo, dependiendo de la unidad de

Total Carbs (Total de carbohidratos) medicién utilizada) activada durante el dia mediante
Bolus Wizard events (Eventos de Bolus Wizard) o
marcadores de carbohidratos de la bomba o el
monitor Guardian.

Ne of Rewinds (N° de rebobinados) Els;:cr}?i(ec;odge rebobinados para la fecha

Prime (or Fill) Volume (U) (Volumen (U) de cebado [o El volumen total de insulina utilizado para eventos
llenado]) de cebado (o llenado) en la fecha especificada.

El volumen total de insulina basal suministrado
durante la fecha especificada (la insulina total
suministrada, menos la suma de todos los bolus
suministrados).

Total Basal (U) (Basal total [U])

Muestra la proporcidn (en % valores total) de

[0) 0
Basal % (% basal) insulina basal a insulina total.

El nimero de eventos bolus grabados para la fecha

Ne of Boluses (N° de bolus) especificada

El nimero de eventos bolus wizard donde la
Bolus Wizard Overrides (Anulacion de Bolus Wizard) cantidad de insulina suministrada es diferente de la
cantidad recomendada.

El nimero de eventos bolus wizard con cantidades
Ne of Correction Boluses (N° de bolus corrector) de corrector superiores a cero que se grabaron en la
fecha especificada.

Como cambiar el orden de las columnas
Para cambiar el orden de las columnas de la tabla de datos, seleccione la columna que desee

. . .= . .
mover y haga clic en las flechas arriba o abajo. | _|(Las flechas situadas en la parte superior e

inferior mueven una columna de datos hasta el comienzo o el final de la lista).
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NOTA: Los elementos situados en la parte superior de la lista Column Order (Orden de
columnas) aparecerdn en la primera columna de la tabla de datos. Los elementos
situados en la parte inferior aparecerdn en la ultima columna de la tabla de datos.

Finalizacion de las preferencias para la generacion de informes

Cuando la lista Column Order (Orden de columnas) tenga todos los datos que desea en el
orden correcto, haga clic en OK (Aceptar).

La tabla de datos tendrd ahora los datos y el orden de columnas que acaba de seleccionar.
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Area de trabajo Profile (Perfil)

Un perfil es similar a la portada de una historia clinica. Contiene informacion del paciente tal
como el nombre y la fecha de nacimiento. Se requiere un perfil para poder recopilar datos de
los dispositivos y utilizarlos para generar informes del tratamiento.

s |
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El drea de trabajo Profile (Perfil) también le permite establecer una conexién a la cuenta del
programa CarelLink Personal. Una vez establecida la conexién, puede recuperar los datos del
paciente almacenados en el programa CareLink Personal en cualquier momento, sin la

necesidad de que el paciente esté presente.

Antes de empezar
Si lo desea, puede personalizar los perfiles de pacientes para que sélo contengan el tipo de

informacién que desea obtener. Si desea mas informacién, consulte el apartado Preferencias
de los perfiles de pacientes en la pdgina 14.
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Ademads, se requieren un nombre de usuario y una contrasefa al configurar la conexién a la

cuenta del programa CareLink Personal de un paciente. El paciente debe estar presente para

proporcionar estos datos.

Como anadir nuevos perfiles

Cada vez que anada un paciente al programa CareLink Pro, deberd comenzar creando un

perfil para el paciente.

1

Seleccione File > New Patient (Archivo > Nuevo paciente) o haga clic en el botén Add

Patient (Anadir paciente). g

Aparece el area de trabajo Profile (Perfil).

NOTA: Para aiiadir o modificar campos en el perfil del paciente, haga clic en
customize fields (personalizar campos). Consulte el apartado Preferencias de los perfiles
de pacientes en la pdgina 14.

Rellene los campos de la seccién Patient Profile (Perfil del paciente).
Haga clic en SAVE (Guardar).

Se afnade el nuevo perfil de paciente a la base de datos del programa CareLink Pro. Aparecera
un mensaje que confirma que se ha guardado el pefrfil.

Rellenar los campos obligatorios

1

Si se intenta guardar un perfil de paciente y no se ha rellenado un campo obligatorio,
aparecera un mensaje junto a ese campo. No podra guardar el perfil hasta que rellene el
campo.

Rellene el campo.
Haga clic en SAVE (Guardar).

Cuando aparezca el mensaje de confirmacion, haga clic en OK (Aceptar).

Edicidon de perfiles de pacientes

-

S W N

Asegurese de que el area de trabajo Profile (Perfil) del paciente esté abierta.

Haga clic en EDIT (Modificar).

Modifique los datos de la seccién Patient Profile (Perfil del paciente) segun proceda.
Haga clic en SAVE (Guardar).

Aparecera un mensaje que confirma que se ha guardado el pefrfil.

CareLink Pro Guia del usuario  Area de trabajo Profile (Perfil) 22



Como eliminar datos de pacientes del programa

1 Asegurese de que el area de trabajo Profile (Perfil) del paciente esté abierta.

2 Compruebe que se trata del paciente que desea borrar. Cuando se borra un perfil de
paciente también se borran sus datos de la base de datos del programa CareLink Pro; esta
accién no puede deshacerse.

3 Haga clic en >> delete patient record (borrar registro de paciente) encima de la seccién de

sincronizacion del perfil.

Aparecera un mensaje que le advierte de que al borrar el registro se borraran todos los datos
del paciente.

4 Haga clic en Yes (Si) para borrar el registro del paciente.

Conexion al programa CareLink Personal

Si el paciente lo permite, puede configurar una conexién con la cuenta de CareLink Personal.
Esta herramienta de Internet permite a los pacientes transferir y guardar los datos de sus
dispositivos y ejecutar diversos informes del tratamiento.

Una vez conectado a la cuenta de CarelLink Personal del paciente, puede recuperar los datos
de sus dispositivos que el paciente haya guardado en ella. Esto es ideal para crear informes de
tratamiento de CarelLink Pro entre las visitas a la consulta. También reduce la necesidad de
leer el dispositivo del paciente a la consulta.

Si un paciente no tiene todavia una cuenta, el programa CareLink Personal puede enviarle un

mensaje de correo electronico invitdndole a crear una.

Como conectar a una cuenta existente

NOTA: El paciente debe estar presente para realizar estos pasos.

1 Asegurese de que estd conectado a Internet.
2 Abra el area de trabajo Profile (Perfil) del paciente.

3 Asegurese de que estén rellenados todos los campos obligatorios de la seccion Patient
Profile (Perfil del paciente).

4 Haga clic en LINK TO EXISTING ACCOUNT (Conectarse a una cuenta existente).
Aparece la pantalla Log In (Inicio de sesidn) del programa CareLink Personal.

5 Pida al paciente que haga lo siguiente:
a. Rellene los campos Username (Nombre de usuario) y Password (Contrasefa).
b. Haga clic en Sign In (Entrar).

Se muestra la pagina Grant Access (Concesion de acceso), basada en los ajustes del idioma y
el domicilio del paciente.

6 Pida al paciente que haga lo siguiente:
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a. Lea la seccion Condiciones de uso.

b. Haga clic para marcar la casilla de verificacion situada junto a la opcion | agree to the
Terms of Use above... (Acepto las condiciones de uso anteriormente expuestas).

c. Haga clic en Grant Access (Conceder acceso).

d. Le avise cuando aparezca la pagina Thank You (Gracias).

Puede imprimir las condiciones de uso para el paciente haciendo clic en el botén Print
(Imprimir). Ya esta conectado a la cuenta del programa CareLink Personal del paciente.

Coémo enviar una invitacién por correo electrénico

Para enviar una invitacion por correo electrénico a un paciente para crear una cuenta del

programa CareLink Personal, siga los pasos descritos a continuacion:

1
2

Abra el area de trabajo Profile (Perfil) del paciente.

Asegurese de que estén rellenados todos los campos obligatorios de la seccién Patient
Profile (Perfil del paciente).

Haga clic en SEND E-MAIL INVITATION TO PATIENT (Enviar invitacion por correo
electrénico al paciente).

S8 E-Masl Invwitation

Patient Mame [S00E PATENT ]

E-Mol Address |
Language |Erghih =
Subjmct flw-m— i s e e ik P anmonad
Maccage [Desr SANFLE FOTIENT -

Woud At rencding His weessag e bemcises your hesith oo priowid er ek B e ba bry
Pedirora Carel ik P ersonal - viebri /dL!:"..JgII'I.'nWQ":"..W-'.'.«.‘E dlheip s 1\?.
el poi hemith cite prosscer bef fer inanage poar Cuhetes. The softeare & ¢
rarad oo dada Thorn vour MEned Parackgm insulin puing and sy of ghi o s
wmsful informabian Ehet vl sl v and sour doctor b ks m.-n!mml braatmank
cmchion.

‘irl: [147]

T stk iesin i Hhos Svcben, Polloss thes beges oigh Bresc bisdoeas
1, Wik bk pe Jhcarelinkrndninned .com
2. Chek on "=ign Lip kics”

2 Completa Hre et stion Fam

W

(=0 ] [cance |

Asegurese de que estén rellenados correctamente los campos Patient Name (Nombre del
paciente), Email Address (Direccion de correo electrénico) y Language (Idioma).

Haga clic en SEND (Enviar).

El drea de estado del perfil del paciente confirma que se ha enviado el mensaje de correo
electroénico.

Como obtener datos de una cuenta con conexion

Si estd conectado a la cuenta del programa CareLink Personal de un paciente, los datos

nuevos que pueda haber en esta cuenta se enviaran automaticamente cada vez que abra su

perfil del paciente en CarelLink Pro.
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NOTA: Para asegurarse de que este proceso tenga lugar, vaya a Tools > Options >
General (Herramientas > Opciones > Generales) y asegtirese de que haya una marca de
verificacion junto a la opcion “Synchronize with CareLink Personal” (Sincronizar con
CarelLink Personal).

Siga los pasos indicados a continuacion para obtener los datos del programa CarelLink Personal
de un paciente en cualquier momento después de haber abierto su perfil de paciente:

1 Asegurese de que el adrea de trabajo Profile (Perfil) del paciente esté abierta y de que esté
conectada a Internet.

2 Seleccione Tools > Synchronize Patient Data (Herramientas > Sincronizar datos del
paciente).

El icono ¢§ de sincronizacion de la ficha del paciente gira. Cuando el icono se detenga,

significa que el proceso ha finalizado.

NOTA: Si el paciente ya no quiere compartir sus datos de Carelink Personal,
aparecerd un mensaje anuncidndoselo.

3 Los datos adicionales obtenidos del programa CarelLink Personal apareceran en los informes
del paciente.

Coémo desvincular la cuenta del programa CareLink Personal de un paciente del
programa CareLink Pro

Puede desvincular la cuenta del programa CarelLink Personal de un paciente del programa
CareLink Pro. Esta opcidon soélo se encuentra disponible si el paciente ya ha estado conectado
previamente. Impide que el programa CareLink Pro continue recuperando datos de la cuenta
del programa CarelLink Personal del paciente. No afecta a la cuenta personal existente del
paciente del programa CareLink Personal.

1 Abra el registro del paciente y vaya al 4rea de trabajo Profile (Perfil).
2 Haga clic en UNLINK ACCOUNT (Desvincular cuenta).

3 Haga clic en YES (Si) en el mensaje de confirmacion. El perfil personal del paciente ya no esta
conectado (Vinculado) al programa CareLink Pro.

El estado cambia a No vinculado y ahora se muestran los botones LINK TO EXISTING
ACCOUNT (Conectarse a una cuenta existente) y SEND E-MAIL INVITATION TO PATIENT

(Enviar invitacion por correo electrénico al paciente).
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Configuracion del hardware

Para leer los datos directamente desde un dispositivo, debe disponer del dispositivo del
paciente y de los cables o dispositivos de comunicacidn necesarios para transferir los datos a

su ordenador.

Alternativamente, si el paciente ha cargado los datos del dispositivo en la cuenta de CareLink
Personal, puede obtener los datos conectando con su cuenta. Para conectar con una cuenta
CarelLink Personal de un paciente, consulte Conexidn al programa Carelink Personal en la

pdgina 23.

Conexion de dispositivos

Observe el esquema general para hacerse una idea de cdmo deben conectarse los dispositivos
para que se comuniquen con el ordenador. Los esquemas presentados a continuacién ilustran

aspectos especificos de la comunicacién de los dispositivos.

Si desea mas detalles, siga las instrucciones mostradas por el programa CareLink Pro durante
la lectura de los dispositivos.
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Descripcion general de la configuracién del hardware

Este ejemplo muestra el uso del USB Carelink para la comunicacién entre la bomba y el

ordenador.

Ejemplos de conexion por cable en serie y USB:
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ComLink opcional para uso con bombas Paradigm:

Com-Station opcional para uso con la bomba Medtronic MiniMed 508
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Area de trabajo Devices (Dispositivos)

La informacién que tendrad que leer del dispositivo de un paciente, como por ejemplo la
marca, modelo, numero de serie, se guarda en el drea de trabajo Devices (Dispositivos). Por
tanto, no tiene que proporcionarla cada vez que lea los datos del dispositivo.

Ly -
et P g 1

(el e dim
; Ve peard- Aavarard ol T
E et gy | - B VR

29

Oy s

Los dispositivos del area de trabajo Devices (Dispositivos) se almacenan en una de estas dos
listas: Active Devices (Dispositivos activos) o Inactive Devices (Dispositivos inactivos). Cuando
se anade un dispositivo, se agrega automaticamente a la lista Active Devices (Dispositivos
activos). Sélo puede leer los datos de los dispositivos que aparezcan en la lista Active Devices
(Dispositivos activos). Estos probablemente seran los dispositivos que utiliza actualmente el
paciente.

Los demas dispositivos pertenecientes al paciente que no se estén utilizando actualmente
pueden guardarse en la lista Inactive Devices (Dispositivos inactivos). La informacion se
guardara en archivo. Estos dispositivos pueden activarse en cualquier momento.
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Antes de empezar

Para poder abrir el area de trabajo Devices (Dispositivos) para un paciente debe tener un peffil
guardado en el programa. Consulte el apartado Cémo anadir nuevos perfiles en la pdgina 22.

Para anadir un dispositivo o leer los datos directamente de él, debe estar en comunicacion
con el ordenador. Consulte en Conexién de dispositivos en la pdgina 26, cémo configurar los
dispositivos para que establezcan comunicaciéon con el ordenador.

Coémo anadir un dispositivo

Puede obtener datos de la cuenta de CarelLink Personal del paciente para un dispositivo aun
no agregado. Dichos dispositivos se agregaran automaticamente cuando los datos se
sincronicen entre CareLink Personal y CareLink Pro.

NOTA: Sélo puede haber una bomba activa por paciente. Si se ariade una nueva bomba,
se pasard la bomba existente a la lista de dispositivos inactivos.

Como anadir una bomba de Medtronic o un monitor Guardian

1 Asegurese de que el dispositivo que estd afladiendo esté configurado para comunicarse con
el ordenador. (Consulte Conexién de dispositivos en la pdgina 26, para ver los pasos para la

conexion).

2 Haga clic en la ficha del paciente o haga doble clic sobre su nombre en la tabla Patient

Lookup (Busqueda de pacientes).

3 Haga clic en Devices ﬂ| (Dispositivos) para acceder al area de trabajo Devices

(Dispositivos) del paciente.
4 Haga clic en ADD DEVICE (Anadir dispositivo).

5 Seleccione Medtronic Pump/Guardian (Bomba de Medtronic/Guardian). Aparece el
asistente Add Medtronic Pump/Guardian (Anadir bomba de Medtronic/Guardian).

£ Add Medironic Pump f Guardian
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NOTA: El modelo de la bomba aparece indicado en la parte posterior de la bomba o
en la pantalla de estado de la bomba.

Seleccione el botdn de opcién para especificar el dispositivo que desea afiadir.
Si ha seleccionado la opcién MiniMed 508 pump (Bomba MiniMed 508), vaya al paso 9.

Haga clic en NEXT (Siguiente). Aparece la pagina Serial Number (Niumero de serie).

= Add Medtronic PFump [ Guardian

Serial Mumbser step 1 =@ q |

Ercerthe device's 81 character ssiel number, Found on the back of the deuice ar on Bhe skatus
ccrian. Sarial numberc may contain lottors ac wal ac numbere.

*¥ leyn mon

Device Serial Mimber:

REF MMTSISHAE
EH PAR
= 1

P e ROr T

NOTA: Se mostrard un mensaje de error si no introduce el numero de serie correcto.
Vea los ejemplos mostrados en esta pdgina y compruebe que estd introduciendo los
caracteres correctos indicados en la parte posterior de la bomba. Si fuera necesario,
vuelva a escribir los seis caracteres.

Utilice los ejemplos mostrados en esta pagina para localizar el nimero de serie de seis
caracteres del dispositivo que desea afadir. (Si necesita mas ayuda para localizarlo, haga clic
en >> learn more [mas informaciénl]). Escriba los seis caracteres en el campo Device Serial
Number (NUmero de serie del dispositivo).

Haga clic en NEXT (Siguiente). Aparece una pagina Communication Options (Opciones de
comunicacion) similar a la mostrada a continuacion.

=8 Add Medtronic Pump § Guardian

Commisnication Oplions Step | z 3 ']
Choose which port your connectivity denvice & attached to.
5 s ey
Choose Port:
él E Aot Dubect [or LISB) “
Conex ) (oo ] [ |
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10 Haga clic en el menu desplegable Choose Port (Elegir puerto) y seleccione el puerto del
ordenador al que se conecta el dispositivo ComLink, Paradigm Link’, USB CareLink o Com-
Station. Si no estd seguro de qué puerto elegir, seleccione Auto Detect (or USB) (Detectar
automaticamente [o USB]).

11 Haga clic en NEXT Siguiente. Aparece la pagina Test Connection (Comprobar conexion),

similar a la mostrada a continuacion.

& hdd Medtranic Pump § Guardian
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12 Siga las instrucciones del dispositivo y haga clic en TEST (Comprobar).

Aparece un mensaje que le informa si la conexién ha sido satisfactoria. Si ha sido asi, vaya al

siguiente paso.

NOTA: Esta comprobacion no lee datos de la bomba, simplemente verifica que las

comunicaciones sean correctas entre la bomba y el ordenador.

Si no lo ha sido, asegurese de que el hardware entre el dispositivo y el ordenador esté
correctamente conectado. Ademads, haga clic en BACK (Atras) en las paginas del asistente
para asegurarse de que los datos del dispositivo introducidos son correctos.

13 Haga clic en DONE (Finalizar).

Se afnade el dispositivo a la lista Active Devices (Dispositivos activos) del paciente.

Como anadir un medidor

1 Haga clic en la ficha del paciente o haga doble clic sobre su nombre en la tabla Patient
Lookup (Busqueda de pacientes).

2 Asegurese de que el medidor que estd afadiendo esté en comunicacion con el ordenador.

(Consulte Conexidn de dispositivos en la pdgina 26, para ver los pasos para la conexion).

3 Haga clic en Devices (Dispositivos) para acceder al area de trabajo Devices (Dispositivos) del

paciente.

4 Haga clic en el boton ADD DEVICE (Anadir dispositivo).
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5 Seleccione Blood Glucose Meter (Medidor de glucosa). Aparece el asistente Add Blood
Glucose Meter (Anadir medidor de glucosa).

J Add Blood Glucose Meter

Meter Brand Sep 1 F 3 1

Selecct e brand of master 1o would Bl o sdd bothe system
bl moew
(%} Medtronic Link Meters
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IR0
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(e Touch (LifeScan)
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6 Haga clic en el botdén de opcion para seleccionar la marca correcta del medidor.

7 Haga clic en NEXT (Siguiente). Aparece la pagina Meter Model (Modelo del medidor); esta
pagina sera diferente segun el fabricante del medidor.

&oAdd Blood Glucose Malor ril
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8 Haga clic para seleccionar el modelo de medidor que desea anadir.
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9 Haga clic en NEXT (Siguiente). Aparece la pagina Communication Options (Opciones de
comunicacion).

o Add Blood Glucose Maler

£

Cosmmumicalion Oplions Step I 7 3 i

Choose wihich poret the meter & connected ko,

B ¥ g Frem

Choose Port:
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NOTA: Sdlo pueden seleccionarse las opciones vdlidas para el medidor que se estd
anadiendo.

10 Haga clic en el menu desplegable Choose Port (Elegir puerto) y seleccione el puerto del
ordenador al que se conecta el dispositivo ComLink, Paradigm Link o USB CareLink. Si no esta
seguro de qué puerto elegir, seleccione Auto Detect (or USB) (Detectar automaticamente [0
USB]).

11 Haga clic en NEXT Siguiente. Aparece la pagina Test Connection (Comprobar conexién).

o Add Blood Glucose Maler El

Tesk Conmection Step I 7 3 Fl
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12 Siga las instrucciones para el medidor y haga clic en TEST (Comprobar).
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Aparece un mensaje que le informa si la conexion ha sido satisfactoria. Si ha sido asi, vaya al
siguiente paso.

Si no lo ha sido, asegurese de que el hardware entre el dispositivo y el ordenador esté
correctamente conectado. Ademas, haga clic en BACK (Atrds) en el asistente para asegurarse
de que los datos introducidos sean correctos.

Haga clic en DONE (Finalizar).

Se anade el medidor a la lista Active Devices (Dispositivos activos) del paciente.

Como activar o desactivar un dispositivo

Los dispositivos del paciente pueden moverse entre las listas Active Devices (Dispositivos

activos) e Inactive Devices (Dispositivos inactivos) segun sea necesario. Un dispositivo debe

estar activo para poder leer datos de él.

Puede tener cuantos medidores desee en la lista Active Devices (Dispositivos activos), pero

sélo puede tener una bomba. Asegurese de que desea desactivar la bomba activa actual antes

de anadir una nueva.

Cémo desactivar un dispositivo

1

Haga clic en la ficha del paciente o haga doble clic sobre su nombre en la tabla Patient
Lookup (Busqueda de pacientes).

Haga clic en Devices (Dispositivos) para acceder al area de trabajo Devices (Dispositivos) del
paciente. Es posible que los dispositivos aparezcan en la lista con el nombre de un
dispositivo equivalente. Consulte el apartado Dispositivos compatibles en la pdgina 2.

Haga clic en >> make this device inactive (desactivar este dispositivo) debajo del
dispositivo que desee desactivar. El dispositivo pasara a la lista Inactive Devices (Dispositivos
inactivos).

Como activar un dispositivo

1

Haga clic en la ficha del paciente o haga doble clic sobre su nombre en la tabla Patient
Lookup (Busqueda de pacientes).

Haga clic en el botén Devices (Dispositivos). Aparece el area de trabajo Devices
(Dispositivos) del paciente.

Es posible que los dispositivos aparezcan en la lista con el nombre de un dispositivo
equivalente. Consulte el apartado Dispositivos compatibles en la pdgina 2.

Haga clic en >> activate this device (activar este dispositivo) debajo del dispositivo que
desee activar.

El dispositivo pasara a la lista Active Devices (Dispositivos activos).
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Cémo borrar un dispositivo

Los pasos descritos a continuacién borraran un dispositivo y sus datos del area de trabajo

Devices (Dispositivos) y del programa CareLink Pro:

1

Haga clic en la ficha del paciente o haga doble clic sobre su nombre en la tabla Patient
Lookup (Busqueda de pacientes).

Haga clic en Devices (Dispositivos) para acceder al drea de trabajo Devices (Dispositivos) del

paciente.

Es posible que los dispositivos aparezcan en la lista con el nombre de un dispositivo
equivalente. Consulte el apartado Dispositivos compatibles en la pdgina 2.

Asegurese de que el dispositivo se encuentre en la lista Inactive Devices (Dispositivos
inactivos). Si no es asi, haga clic en >> Inactivate this device (Desactivar este dispositivo) en

la lista actual.

Haga clic en >> delete this device (borrar este dispositivo) debajo del dispositivo que desee
borrar. Aparecerd un mensaje que le advierte de que se borraran del registro del paciente el
dispositivo y todos sus datos.

Haga clic en YES (Si) para borrar el dispositivo.

El dispositivo y sus datos se borran del drea de trabajo Devices (Dispositivos) y del programa
Carelink Pro. Los datos de este dispositivo ya no estan disponibles para su uso en informes.

Como leer los datos de un dispositivo

Una forma de obtener los datos de un dispositivo es conectarse a la cuenta existente del

programa CareLink Personal del paciente. (Consulte Conexién al programa Carelink Personal en

la pdgina 23). Otra forma es leerlos directamente del dispositivo, tal como se describe en este

capitulo.

El programa CarelLink Pro puede leer los datos del dispositivo de un paciente si el dispositivo

estd en la lista Active Devices (Dispositivos activos) y esta en comunicacién con el ordenador.

Una vez obtenidos los datos, puede utilizarlos para crear informes que ayuden a evaluar la

gestion del tratamiento del paciente. Consulte Acerca de los informes en la pdgina 46 para ver

una breve descripcién de los informes disponibles.

CareLink Pro puede recopilar los siguientes datos de una bomba de insulina:

Diversos pardmetros de la bomba, como el modo de alerta, el volumen de los pitidos y la

presentacién de la hora

Cantidades de insulina basal administradas
Episodios de bolus y cantidades administradas
Entradas de la funciéon Bolus Wizard
Cantidades de cebado

Periodos de suspension

CareLink Pro Guia del usuario  Area de trabajo Devices (Dispositivos) 36



«  Lecturas de glucosa del sensor durante un periodo de tiempo, en bombas con funciones de
sensor

El sistema también puede reunir datos de sistemas Guardian REAL-Time, incluyendo los
siguientes:

«  Lecturas de los valores del sensor (Sen)
«  Valores de coeficiente del sensor

«  Factores de calibracion del sensor

«  Marcadores de comida

+ Inyecciones de insulina

Ademas, diversa informacion almacenada en un medidor de glucosa en sangre puede
descargarse al programa durante una lectura del dispositivo.

ADVERTENCIA: Cancele o termine los bolus activos o los indices basales temporales y
resuelva las alarmas activas. Se suspenderd el funcionamiento de la bomba durante la
lectura. Una vez concluida la lectura, aseglrese de que se haya reanudado el
funcionamiento de la bomba.

PRECAUCION: No utilice el control remoto de la bomba durante la lectura de la misma. Si
la carga de la pila de la bomba estd baja, la bomba no enviara datos al PC. Sustituya la
pila si el indicador de estado muestra que la carga de la pila estd baja.

1 Haga clic en la ficha del paciente o haga doble clic sobre su nombre en la tabla Patient
Lookup (Busqueda de pacientes).

2 Asegurese de que el dispositivo del paciente esté en comunicacion con el ordenador.

(Consulte Conexién de dispositivos en la pdgina 26).

3 Haga clic en Devices (Dispositivos) para acceder al area de trabajo Devices (Dispositivos) del

paciente.

Es posible que los dispositivos aparezcan en la lista con el nombre de un dispositivo
equivalente. Consulte el apartado Dispositivos compatibles en la pdgina 2.

4 Localice el dispositivo del que desea obtener datos en la lista Active Devices (Dispositivos

activos) y asegurese de que los datos del campo Choose port (Elegir puerto) sean correctos.

Para las bombas, haga clic en el menu desplegable Amount of Data (Cantidad de datos) y
seleccione la cantidad de datos de la bomba que desea que lea el programa Carelink Pro.

5 Haga clic en el botén READ DEVICE (Leer dispositivo) asociado.
6 Siga las instrucciones especificas del dispositivo y haga clic en OK (Aceptar).

7 El programa CareLink Pro muestra una barra de progreso que se actualiza para mostrar el
porcentaje completado de la lectura del dispositivo.
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Si hace clic en CANCEL (Cancelar) durante la lectura del dispositivo, se mostrard un mensaje
para advertirle de que si se cancela la acciéon podrian perderse todos los datos leidos hasta
ese momento. Necesitard hacer clic en el botén READ DEVICE (Leer dispositivo) para reiniciar
el proceso de carga.

- Para cancelar el proceso, haga clic en YES (Si).

- Para continuar la lectura de los datos del dispositivo, haga clic en NO.

Cuando el programa concluya la lectura de los datos del dispositivo, aparecera un mensaje
que confirma que la lectura del dispositivo ha finalizado.

8 Haga clic en OK (Aceptar)).
- Paralas bombas de insulina, siga las instrucciones para sacarlas del modo de suspensién.

Si CareLink Pro no puede obtener datos del dispositivo, consulte Resolucién de problemas
para obtener mas ayuda.
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Area de trabajo Reports (Informes)

El programa CarelLink Pro proporciona una serie de informes que le ayudan a gestionar mejor
el tratamiento de diabetes de los pacientes. La informaciéon contenida en cada informe se
basa en los datos que obtiene de los dispositivos de los pacientes y sus cuentas del programa

CareLink Personal.
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Los informes pueden generarse en la pantalla, enviarse directamente a una impresora o
guardarse como archivos TIFF o PDF que puede adjuntar a una historia clinica electrénica.

Puede generar varios tipos de informes en una sola operacién.

Los datos mostrados en estos informes proceden de los dispositivos del paciente, de su

cuenta del programa CarelLink Personal o de ambas fuentes.

NOTA: En la guia de referencia para informes se presenta informacion mds detallada
sobre los componentes de los informes, asi como ejemplos de los informes. Puede acceder
a la Guia de referencia para informes a través del programa Carelink Pro dirigiéndose a
Help>View Report Reference Guide (Ayuda>Ver Guia de referencia para informes) (PDF), y

seleccionando el idioma adecuado.
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Antes de empezar

Si desea reflejar un periodo de tiempo en un informe, debe tener los datos del dispositivo del
paciente correspondientes a dicho periodo. Es posible que también necesite tener el
dispositivo del paciente conectado al ordenador para obtener datos recientes antes de

generar informes.

Lea atentamente el paso Comprobacion de la configuraciéon de los informes antes de
generar un informe. Ahi puede configurar detalladamente un informe para registrar los datos
que desee del paciente.

Crear informes

Las siguientes secciones le ayudaran a entender mejor los informes que puede consultar y el
proceso que se utiliza para generarlos.

Si estd familiarizado con el proceso de generacién de informes y sabe qué informes le gustaria

ejecutar, puede comenzar a generar informes.

Como abrir el area de trabajo Reports (Informes)

Haga clic en la ficha del paciente o haga clic en el boton Open Patient (Abrir paciente) & vy
haga doble clic en su nombre.

Aparece el 4rea de trabajo Reports (Informes).

NOTA: Para asegurarse de que dispone de los datos del dispositivo mds recientes
procedentes de la cuenta del programa Carelink Personal del paciente, haga clic en SYNC
DATA (Sincronizar datos).

Seleccionar el periodo del informe

1 Para cambiar el periodo de tiempo reflejado en los informes, haga clic en el menu
desplegable Duration (Duracion) y seleccione la cantidad de tiempo que desee. (La duracién
maxima es de 12 semanas).

2 Las fechas desde y hasta se definen automaticamente, a menos que seleccione la opcién

custom date range (intervalo de fechas personalizado).

NOTA: Si selecciona un intervalo de fechas superior al permitido, se mostrard un
mensaje de error. Ajuste la duracion o las fechas.

Si desea un intervalo de fechas personalizado, haga clic en los menus desplegables From
(Desde) o Through (Hasta) y seleccione el dia, el mes o el afo que desee.
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Calendario de datos

El area del calendario de datos del area de trabajo Reports (Informes) muestra un intervalo de
tres meses de informacién para informes.

Las barras azules representan datos del dispositivo. La barra naranja representa el periodo del
informe que selecciond. Si existe una superposicion de los datos de los dispositivos y del
periodo de informe, significa que dispone de datos de parte del periodo del informe mostrado
o de todo el periodo.
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El drea del calendario de datos muestra inicialmente los tres meses mas recientes. Para ver

otros meses, haga clic en los botones de flecha ¢ # situados a ambos extremos de los meses.

Como seleccionar los datos originales que se desea incluir

1 Si el paciente utiliza un medidor de glucosa vinculado a su bomba de insulina, haga clic para
elegir una de las siguientes opciones para generar un informe con los datos del medidor de
glucosa:

- in the pump (en la bomba): las ventajas de esta seleccidén son que sélo tiene que leer los
datos de la bomba del paciente, que las lecturas de glucosa en sangre llevan la fecha y la
hora registradas por la bomba y que las lecturas se vinculan directamente a los calculos
de la funcion Bolus Wizard utilizados. Un inconveniente es que si existen problemas de
comunicacion entre la bomba y el medidor vinculado, es posible que no se incluyan en
el informe las lecturas de glucosa en sangre correspondientes a ese periodo de tiempo.
Ademas, para las bombas MiniMed Paradigm anteriores al Modelo 522/722, no se
incluyen en los informes las lecturas de glucosa en sangre derivadas de los calculos de la
funcién Bolus Wizard sobre las que no se actua.

- In the link meter(s) (en el medidor vinculado): la ventaja de esta seleccién es que se
incluyen en el informe todas las lecturas guardadas en el medidor vinculado. El
inconveniente es que para relacionar los datos del medidor y de la bomba, debe haberse
asegurado de que los relojes de la bomba y del medidor estan sincronizados entre si.
También debe leer los datos de la bomba y del medidor vinculado por separado.

2 Para anadir los datos de un dispositivo a los informes, seleccione la casilla de verificacion
situada junto al dispositivo en cuestion.

No puede anadir dispositivos que hayan sido excluidos a consecuencia de la seleccién
realizada en el paso 1. Para cambiar esto, seleccione la otra opciéon del medidor vinculado.

3 Para excluir los datos de un dispositivo de los informes, elimine la marca de la casilla de
verificacion situada junto al dispositivo en cuestion.
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No puede eliminar las marcas de verificacion relacionadas con la opcién seleccionada en el
paso 1. Para cambiar esto, seleccione la otra opcién del medidor vinculado.

Comprobar los datos de los dispositivos

1

Compruebe en el drea del calendario de datos del 4rea de trabajo Reports (Informes) si la
barra naranja que representa el periodo del informe se superpone con las barras azules que
representan los datos de los dispositivos.

Si las barras se superponen en todo el periodo del informe, dispone de datos para los
informes. Puede hacer clic en NEXT (Siguiente) e ir al apartado Comprobar la configuracién de
los informes en la pdgina 43.

Si las barras no se superponen, o si la superposicion no es suficiente, tiene dos opciones:
- Ajustar el periodo del informe.
- Obtener datos adicionales de los dispositivos.

Como obtener datos adicionales de los dispositivos

1

Para obtener mas datos de un dispositivo, haga clic en el boton READ DEVICE (Leer
dispositivo) asociado al dispositivo.

Se muestra la barra Read Device (Leer dispositivo).
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ADVERTENCIA: Cancele o termine los bolus activos o los indices basales temporales y
resuelva las alarmas activas. Se suspenderd el funcionamiento de la bomba durante la
lectura. Una vez concluida la lectura, aseglrese de que se haya reanudado el
funcionamiento de la bomba.

PRECAUCION: No utilice el control remoto de la bomba durante la lectura de la
misma. Si la carga de la pila de la bomba estd baja, la bomba no enviard datos al
PC. Sustituya la pila si la pantalla de estado del dispositivo indica que la carga de la
pila estd baja.

Compruebe que los datos del campo Choose port (Elegir puerto) sean correctos para este
dispositivo.

Para cambiar este valor, haga clic en el menu desplegable del campo y seleccione un valor
diferente.

Asegurese de que el dispositivo esta conectado al ordenador.
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Si el dispositivo es una bomba, puede especificar la cantidad de datos que desea obtener de
ella. Haga clic en el menu desplegable Amount of Data (Cantidad de datos) y seleccione una
cantidad.

NOTA: Si selecciona All available data (Todos los datos disponibles), el sistema leerd
todos los datos Se sobrescribirdn los datos duplicados que haya en el sistema.

Haga clic en READ DEVICE (Leer dispositivo). Lea detenidamente el mensaje mostrado, ya

que proporciona instrucciones especificas para leer la bomba.

Siga las instrucciones y haga clic en OK (Aceptar).

Se muestra la barra de progreso de lectura del dispositivo.

Puede decidir cancelar la lectura en cualquier momento haciendo clic en CANCEL (Cancelar).
Aparecerd un mensaje que confirma que la lectura ha finalizado.

Haga clic en OK (Aceptar).

Los datos del dispositivo se visualizaran entonces en el calendario de datos.

Haga clic en NEXT (Siguiente) en la parte superior del area de trabajo Reports (Informes).

Se muestra el paso Verify Report Settings (Comprobar la configuracién de los informes). Esto
le permite asegurarse de que la configuracidén para este paciente es correcta antes de
generar el informe.

Comprobar la configuracién de los informes

1

Asegurese de que los valores del drea Glucose Target (Objetivo de glucosa) son los
deseados. Escriba estos valores o haga clic en las flechas arriba o abajo de los campos Low

(minimo) y High (maximo) para aumentar o disminuir los valores.

NOTA: Los marcadores de lectura de medidores (|| |) se muestran en la linea
cronolégica de despertar y hora de dormir, ademds de en la linea cronolégica de los
marcadores de comida. Como algunos de los informes se basan en datos encontrados
dentro de las horas de las comidas definidas, horas de despertar y de dormir, es
importante que se agrupen correctamente un evento Bolus Wizard del paciente y los
marcadores de lectura de medidores.

Para afadir un nuevo periodo de comida, haga clic en ADD MEAL (Anadir comida). Para
modificar un periodo de comida existente, haga clic en cualquier punto del periodo de
comida a lo largo de la linea temporal.

El editor Meal Period (Periodo de comida), situado bajo la linea temporal, se activa.

NOTA: Puede tener hasta cinco periodos de comida. Los periodos predeterminados son
desayuno, comida y cena.
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Introduzca texto o haga clic en las flechas para seleccionar la configuraciéon que desee.

Si solo desea utilizar esta configuracion para esta comida, elimine la marca de la casilla de
verificacion Use these parameters for all of this patient's meals (utilizar estos
parametros para todas las comidas de este paciente).

- Meal Name (Nombre de la comida): nombre que desea asignar al periodo de comida.

- Meal Time Period (Periodo de tiempo de comida): horas entre las que tiene lugar la
comida.

- Pre-Meal BG Target (Objetivo de glucosa en sangre antes de la comida) (mg/dl o
mmol/l): limites inferior y superior del intervalo del objetivo de glucosa antes de la
comida del paciente.

- Pre-Meal Analysis Period (Periodo de analisis previo a la comida): periodo de tiempo
en el que la glucosa sera analizada, antes del inicio de una comida. Las lecturas de
glucosa registradas durante este tiempo se utilizan para un analisis de informe detallado.

- Post-Meal BG Target (Objetivo de glucosa en sangre después de la comida) (mg/dI|
o mmol/l): limites inferior y superior del intervalo del objetivo de glucosa después de la
comida del paciente.

- Post-Meal Analysis Period (Periodo de analisis posterior a la comida): periodo de
tiempo en el que la glucosa serd analizada después de una comida. Las lecturas de
glucosa registradas durante este tiempo se utilizan para un analisis de informe detallado.

Puede cambiar la duracién de un periodo de comida existente o del periodo de
despertarse o acostarse haciendo clic en los tiradores inicial o final y arrastrandolos y
soltandolos en la linea temporal.

NOTA: Los periodos de las comidas no pueden superponerse, pero las lineas inicial y
final de los distintos periodos pueden estar contiguas. Los periodos de comida deben
tener una duracion de al menos 60 minutos.

Para utilizar la configuracion de esta comida para las demas comidas del paciente, asegurese
de que esté seleccionada la casilla de verificacidon situada junto a la opcion Use these
parameters for all of this patient’s meals (Utilizar estos pardmetros para todas las comidas
de este paciente).

Cuando haya finalizado de crear o editar un periodo de comida, haga clic en SAVE (Guardar).

Para borrar un periodo de comida, haga clic en DELETE MEAL (Borrar comida). Haga clic en
DELETE (Borrar) cuando se le pida que confirme la accion.

El programa Carelink Pro puede recordar esta configuracion para este paciente la siguiente
vez que genere un informe para él. Para guardar la configuraciéon para este paciente, haga
clic en SAVE SETTINGS (Guardar configuracion).

Haga clic en NEXT (Siguiente) en la parte superior del area de trabajo Reports (Informes).
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Este es el paso Select and Generate Reports (Seleccionar y generar informes) del proceso.

Proporciona una lista de tipos de informes y una tabla de datos que le ayuda a incluir o
excluir ciertos dias de datos de los informes Daily Detail Report (Informe de detalles diarios).
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NOTA: Para modificar la presentacion de la tabla de datos, haga clic en >> customize
columns (personalizar columnas). Consulte el apartado Preferencias para la generacion

de informes en la pdgina 17.

9 Para imprimir una pantalla, haga clic en el icono PRINT (Imprimir) .

Seleccionar los tipos de informes y las fechas de inclusion

1

Seleccione la casilla de verificacion situada junto a los informes que desee incluir en el

conjunto de informes.

Si se han leido los datos de una bomba o de un monitor Guardian mas de una vez durante

este periodo de informe, es posible que haya varias imagenes del dispositivo:

a. Asegurese de que esté seleccionada la casilla de verificacion situada junto a la opcion

Device Settings Snapshot (Imagen de la configuracién del dispositivo).
b. Haga clic en la flecha de menu desplegable y seleccione la fecha y la hora de una

imagen.

Bombas: seleccione una imagen de la bomba del paciente.

Guardian: seleccione una imagen del monitor Guardian del paciente.
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Si el campo aparece atenuado, significa que no hay imagenes disponibles para el periodo del
informe.

Recorra la tabla de datos para revisar la informacién de los informes Daily Detail Report

(Informe de detalles diarios) disponible.

- Puede ordenar los datos en cada columna. Haga clic en el encabezado de la columna
para ordenar los datos en orden ascendente. Haga clic de nuevo en el encabezado para
ordenar los datos en orden descendente.

NOTA: Si no hay datos para una fecha concreta, no podrd seleccionar esa fecha.

Seleccione la casilla de verificacion de las filas de la tabla de datos para las fechas para las

que desee un informe Daily Detail Report (Informe de detalles diarios).

- Para incluir o excluir todas las fechas del informe de detalles diarios con un solo clic,
seleccione la casilla de verificacion situada en la parte superior de la columna de casillas
de verificacion de la tabla de datos.

Generar informes

1

Una vez que haya verificado las selecciones para los informes, haga clic en GENERATE
REPORTS (Generar informes) en la parte superior del drea de trabajo Reports (Informes).

Se presenta una lista de opciones.

Seleccione una opcion para mostrar una vista previa de los informes, imprimirlos o
guardarlos.

Si ha seleccionado la opcion Preview (Vista previa), aparecerd la ventana Preview (Vista

previa).

Haga clic en los botones de flecha para desplazarse por los informes que tengan varias
paginas.

Haga clic en uno de los otros botones en la parte superior de la ventana Preview (vista
previa) para guardar o imprimir los informes.

tats bl @ e w @ T ot toPor | L] Gaport to TUF | 5 Print | 7] Report Relerence Guide » | [ Close

Para cerrar esta ventana, haga clic en el botén Close (Cerrar) E situado en la esquina
superior derecha de la ventana.

Acerca de los informes

Este apartado proporciona una descripcién de cada informe. En la guia de referencia para

informes se presenta informacion mas detallada sobre los componentes de los informes, asi

como ejemplos de los informes. Puede acceder a la guia de referencia para informes a través
de Carelink Pro:

1

Help > View Report Reference Guide (PDF) (Ayuda > Ver guia de referencia para
informes [PDF]).
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2 Seleccione un idioma para la guia de referencia para informes.
Los informes del programa CareLink Pro tienen los siguientes elementos en comun:

- Encabezado del informe: el encabezado del informe contiene informacion de identificacion,

como el nombre del informe, el nombre del paciente y el origen de los datos.

+ Niveles de carbohidratos y glucosa en sangre: en los gréficos y tablas las unidades de
carbohidratos se muestran en cursiva y los niveles de glucosa en sangre se muestran en
negrita.

- Datos del fin de semana: los dias del fin de semana se muestran en negrita para poder
identificarlos facilmente.

- Leyendas: en la parte inferior de cada informe se muestra una leyenda de los simbolos.
Aunque un simbolo puede ser utilizado en varios informes, las leyendas son exclusivas para
cada informe.

Informe Adherence (Cumplimiento)

Este informe Adherence presenta datos que describen cémo se utilizan las bombas de insulina
y los sensores, asi como el comportamiento del paciente en relacién con su tratamiento.
Responde a la pregunta “;Habia suficientes datos para obtener una idea precisa de cobmo
utiliza el paciente la bomba de insulina y el sensor, si procede?”. También responde a la
pregunta “;Cumplen los pacientes el tratamiento tal como se les ha indicado?”. Indica
también si puede ser necesario hablar con el paciente acerca de la forma en que esta
controlando su diabetes.

Informe Sensor and Meter Overview (Resumen del medidor y del sensor)

El informe Sensor and Meter Overview Report (Informe de resumen del medidor y del sensor)
proporciona una representacién grafica de los niveles diarios y las medias de glucosa del
paciente, incluido un desglose por horas durante 24 horas y su relacién con las comidas y los
patrones de sueno. También se incluyen estadisticas sobre las lecturas de glucosa y el uso de
insulina por el paciente.

Si se dispone de datos del sensor se genera un analisis similar de dichos datos como primera
pagina del informe. Si no se dispone de datos del sensor, la primera pagina sera la pagina de
analisis de los datos del medidor.

Las péginas finales del informe muestran el nivel dia a dia y la calidad del control de la
glucemia, de los carbohidratos y de la insulina del paciente. Cada pagina muestra la variacién
de ese control cada dia durante todo el periodo del informe, con un maximo de 14 dias por
pagina.
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Informe Logbook (Libro de registro)

El informe Logbook Report (Informe Libro de registro) proporciona datos de insulina, de
carbohidratos y de glucosa del medidor para cada dia del periodo del informe. Ofrece un
diario de los eventos registrados cada hora, asi como los promedios y totales diarios. Cada
pagina contiene un maximo de 14 dias. Si el periodo del informe es superior a 14 dias, se

generaran paginas adicionales.

Device Settings Snapshot (Imagen de la configuracion del dispositivo)

Este informe presenta una imagen de la configuracién de la bomba o del monitor Guardian
REAL-Time del paciente para una fecha y una hora especificas. Puede ayudarle a comprender

otros informes o simplemente documentar la configuraciéon del paciente.

La configuracién de la bomba o del monitor sélo se registra durante la lectura del dispositivo.
Si no se ha leido el dispositivo durante el periodo del informe, no se dispondra de ajustes de

configuracion.

Informe de detalles diarios

El informe Daily Detail Report (Informe de detalles diarios) muestra los datos de glucosa, las
cantidades de carbohidratos y la utilizacién de insulina por el paciente para el dia
seleccionado. Se genera un informe diferente para cada dia seleccionado en la tabla de datos.

El informe Daily Detail Report (Informe de detalles diarios) proporciona informacién detallada
de cada dia seleccionado. Le permite centrarse en un dia determinado si piensa que ese dia
ocurrié algo importante para el tratamiento del paciente.

Cémo exportar datos

Puede exportar datos de dispositivos que el programa CarelLink Pro haya adquirido y
guardado. Esto le permite disponer de todos los datos de los dispositivos de un paciente para
utilizarlos para generar estadisticas o crear informes o graficos especializados. El archivo .csv
puede importarse en Microsoft Excel o en ciertos programas de estadisticas clinicas en los que
puede manipular los datos.

El archivo .csv contiene datos que registran las acciones del dispositivo. Por ejemplo, presenta
una lista del registro de las lecturas del medidor, la bomba que recibié el valor de la lectura

del medidor o el cambio del indice basal.

NOTA: Se trata de una funciéon avanzada y requiere que esté familiarizado con los datos
sin procesar del dispositivo. También requiere un dominio del programa de software en el

que importe el archivo .csv.

Siga los pasos descritos a continuacion para utilizar la funcién de exportacion del programa
CarelLink Pro:
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Haga clic en la ficha del paciente o haga clic en el botén Open Patient (Abrir paciente) & vy
haga doble clic en su nombre.
Asegurese de que aparece el area de trabajo Reports (Informes).

Utilice los campos Duration (Duracion) o From/Through (Desde/Hasta) para definir las
fechas y la duracién del informe.

La duracion maxima que puede seleccionar es 12 semanas.
Haga clic en el vinculo export selected data (exportar datos seleccionados).
Aparece el cuadro de didlogo Export Data to CSV File (Exportar datos a archivo CSV).

Vaya a la ubicaciéon donde desea guardar el archivo .csv en su ordenador. Si desea cambiar el
nombre del archivo, escribalo en el cuadro File name (Nombre del archivo).

Haga clic en SAVE (Guardar).

NOTA: Si desea mds informacion sobre los datos presentados en los archivos CSV,
consulte el apéndice de datos CSV.

El archivo .csv ya estd guardado en el ordenador en la ubicacion seleccionada. A
continuacién puede importarlo en cualquier programa que sea compatible con este tipo de
archivo.
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Administracion del programa

Es importante que haga periédicamente una copia de seguridad de la base de datos del
programa Carelink Pro. La base de datos almacena todos los datos del programa que se
hayan acumulado en los registros de pacientes, incluida la informacion del perfil, los datos
procedentes de los dispositivos y la configuracion de los informes.

También es importante que tenga la version mas reciente del programa Carelink Pro.
Periédicamente estaran disponibles versiones actualizadas que pueden contener importantes
mejoras. Puede elegir buscar actualizaciones o ser avisado cuando éstas estén disponibles.

Actualizaciones del software

En ocasiones habra actualizaciones del programa CarelLink Pro. Cuando se muestre un aviso
de una actualizacién, siga los pasos descritos a continuacién para descargar la version mas

reciente del programa.

NOTA: Antes de aplicar una actualizacion del programa debe hacerse una copia de
seguridad de la base de datos. Consulte el apartado Hacer una copia de seqguridad de la
base de datos en la pdgina 52.

1 Asegurese de que dispone de una conexion a Internet y de que ésta esta activa en el
ordenador.

2 Se mostrarad el mensaje de actualizacién del programa CarelLink Pro cuando exista una
actualizacion del programa. Le ofrece la posibilidad de descargar la actualizacién.

3 Haga clic en DOWNLOAD (Descargar). (Si hace clic en CANCEL [Cancelar], se cerrara el aviso
de actualizacién. Puede descargar la actualizacion mas adelante).

Aparecerd un mensaje de advertencia que recomienda hacer una copia de seguridad de la
base de datos.
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4 Haga clic en YES (Si) para crear una copia de seguridad de la base de datos (consulte el
apartado Hacer una copia de seguridad de la base de datos en la pdgina 52, para este
procedimiento). Haga clic en NO si ya ha hecho copia de seguridad de los datos.

Aparecerd un mensaje que confirma que se ha descargado la nueva versiéon del programa
CareLink Pro.

5 Para comenzar a utilizar la versién mas reciente del programa CareLink Pro, haga clic en YES
(Si) para cerrar y volver a abrir el programa. Haga clic en NO si prefiere esperar antes de
reiniciar el programa CareLink Pro.

Como desactivar las actualizaciones automaticas

Si no desea recibir una notificacion automatica de las actualizaciones del programa CareLink
Pro, siga los pasos descritos a continuacion:

1 Seleccione Tools > Options (Herramientas > Opciones).
2 Haga clic en la ficha General (Generales).

3 Enlaseccién Communications (Comunicaciones), elimine la marca de la casilla de verificacién
situada junto a la opcion Automatically check for software updates (Comprobar
automaticamente la disponibilidad de actualizaciones del programa).

Cémo comprobar manualmente la disponibilidad de actualizaciones

Puede comprobar manualmente la disponibilidad de actualizaciones del programa CareLink

Pro en cualquier momento.

NOTA: Antes de aplicar una actualizacion del programa debe hacerse una copia de
seguridad de la base de datos. Consulte el apartado Hacer una copia de seqguridad de la
base de datos en la pdgina 52.

1 Asegurese de que dispone de una conexion a Internet y de que ésta esta activa en el
ordenador.

2 Seleccione Tools > Check for Software Updates (Herramientas > Comprobar la
disponibilidad de actualizaciones del programa).

3 Si no hay actualizaciones disponibles, se mostrard el mensaje correspondiente. Si hay una
actualizacion disponible, se mostrard un mensaje de actualizacién del programa CareLink Pro.

4 Siga el procedimiento descrito en el apartado Actualizaciones del software en la pdgina 50.

Copia de seguridad y restauracion de la base de datos

Se recomienda establecer un plan periédico de copias de seguridad de la base de datos. Esto
ayudard a asegurarse de que se realicen de forma periddica y reducird al minimo el riesgo de
pérdida de datos.
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Si va a hacer una copia de seguridad o una restauracién de la base de datos, el programa le
avisara si hay usuarios activos del programa en otros ordenadores.

Hacer una copia de seguridad de la base de datos

Los siguientes pasos le permiten hacer una copia de seguridad de la base de datos actual en la
ubicacién que usted seleccione.

1 Asegurese de que todos los registros de pacientes estan cerrados.

2 Seleccione Tools > Backup Database (Herramientas > Copia de seguridad de la base de
datos).

NOTA: Las copias de seguridad de la base de datos pueden guardarse en una unidad
de red o en un medio de almacenamiento extraible (DVD, CD, unidad USB, etc.).

3 Vaya a la ubicacion donde desea guardar el archivo de copia de seguridad en su ordenador.
Si desea cambiar el nombre del archivo de copia de seguridad, escribalo en el cuadro File
name (Nombre del archivo).

4 Haga clic en Save (Guardar). Mientras se guarda la base de datos aparece una barra de
progreso.

Cuando la copia de seguridad finalice, aparecera un mensaje.

5 Haga clic en OK (Aceptar) para cerrar el mensaje.

Restaurar la base de datos

Puede ser necesario sustituir la base de datos actual en caso de que no sea posible acceder
a ella o utilizarla. Cuanto mas reciente sea la copia de seguridad, menos datos se perderan
si sustituye la base de datos.

PRECAUCION: Cuando se restaura la base de datos con una copia de seguridad, se pierden
todos los datos nuevos creados en la base de datos actual desde que se realizara la copia
de seguridad seleccionada.

Los siguientes pasos le permiten seleccionar una copia de seguridad para sustituir la base de
datos actual.

1 Asegurese de que todos los registros de pacientes estan cerrados.
2 Seleccione Tools > Restore Database (Herramientas > Restaurar la base de datos).

3 Seleccione el archivo de copia de seguridad que desee utilizar para sustituir la base de datos
actual (generalmente el mas reciente).

4 Haga clic en Open (Abrir). Se muestra un mensaje de aviso que le recuerda que pueden
perderse datos si continta la restauracidon de la base de datos.

5 Haga clic en OK (Aceptar) para continuar. Mientras se restaura la base de datos aparece una
barra de progreso.
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Cuando se haya restaurado la base de datos, aparecerd un mensaje.

6 Haga clic en OK (Aceptar) para cerrar el mensaje.

Cuando el programa no esta disponible

Si intenta iniciar el programa mientras otro usuario esta realizando una copia de seguridad o
una restauracion, recibird un mensaje avisandole de que el programa no esta disponible. No

podra acceder al programa hasta que haya finalizado la operacion.
Realice una de las acciones siguientes:
«  Espere a que finalice el proceso y a que el programa esté disponible.

« Haga clic en CANCEL (Cancelar) e inténtelo de nuevo mas tarde.
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Resolucion de problemas

Este capitulo tiene por finalidad ayudarle a resolver los problemas que puedan surgir durante
el uso del programa CareLink Pro. También contiene instrucciones para desinstalar CareLink

Pro si es necesario.

Errores generales de uso del programa

Si intenta descargar una actualizacién del programa a través de Internet, es posible que
aparezca un mensaje que le indique que no tiene suficientes privilegios para ello. Debe tener

privilegios administrativos para descargar actualizaciones del programa CareLink Pro.
1 Cierre el programa CareLink Pro y reinicie el ordenador.
2 Pida a alguien que tenga privilegios administrativos que inicie una sesién en el ordenador.

3 Siga las instrucciones descritas en el apartado Actualizaciones del software en la pdgina 50.

No hay conexidn con la base de datos

Un mensaje de error que indica que no esta conectado a la base de datos indica una de las

posibilidades siguientes:

«  Se ha movido la base de datos. La base de datos debe estar ubicada en el mismo lugar
seleccionado durante la instalacion del programa CareLink Pro. Si se ha movido, debera

devolverse a la ubicacion seleccionada durante la instalacion.

+  No estd conectado a la unidad de red en la que se encuentra la base de datos. Si la base de
datos esta ubicada en una unidad de red, en ocasiones la red podria experimentar problemas
que le impidan acceder a la unidad. Péngase en contacto con el departamento informatico
para solicitar ayuda para volver a conectarse a la unidad de red en la que se encuentra la

base de datos.
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Ha olvidado la contrasena del centro para el programa CareLink Pro

Si nadie recuerda la contrasefa que utiliza el centro médico para iniciar una sesién en el

programa CareLink Pro, se debera reinstalar el programa y crear una nueva base de datos. Una

vez haya reinstalado el programa, no podrd acceder a ninguna informacién de los pacientes

que estuviera almacenada en la base de datos anterior. Guarde la contrasefia que cree

durante la nueva instalacién en algun lugar de la consulta, de forma que no pierda los datos

futuros.

Errores de lectura de dispositivos

The selected serial port could not be opened. Another
operation might be in progress on that port. Please
wait until the port is available, or select another port.
(No ha sido posible abrir el puerto en serie
seleccionado. Es posible que haya otra operacion en
curso en ese puerto. Espere a que el puerto esté
disponible o seleccione otro puerto).

Compruebe que el puerto COM seleccionado no
esté siendo utilizado por otro programa o
seleccione un puerto diferente. Pruebe a reiniciar
el ordenador que esta utilizando e intente leer el
dispositivo de nuevo. Es posible que el hardware
(cable, etc.) conectado al puerto o el propio puerto
estén danados. Conecte el hardware a otro puerto e
intente leer el dispositivo de nuevo para identificar
el problema.

Auto Detect could not find the device on any available
port. Please check the cable connection, device battery
& status and try again, or try specifying a serial port. (La
funcién de deteccién automatica no ha encontrado el
dispositivo en ningun puerto disponible. Compruebe la
conexion del cable y la bateria y el estado del
dispositivo e inténtelo de nuevo, o pruebe a especificar
un puerto en serie).

Compruebe la conexion entre el cable y el PCy
asegurese de que el estado de la bateria del
dispositivo sea correcto. Si es asi, pruebe a
especificar el puerto en serie del PC al que esta
conectado el cable en lugar de seleccionar la
opcidn Auto Detect (Deteccion automatica).

Device not found at selected serial port. Please check
the cable connection, device battery & status and try
again, try selecting a different port, or try to Auto
Detect the device. (No se ha encontrado el dispositivo
en el puerto en serie seleccionado. Compruebe la
conexion del cable y la bateria y el estado del
dispositivo e inténtelo de nuevo, o pruebe a seleccionar
un puerto diferente o utilice la opcién Auto Detect
[Deteccién automatical).

Compruebe la conexion entre el cable y el PCy
asegurese de que el estado de la bateria del
dispositivo sea correcto. Si es asi, pruebe a
seleccionar un nimero de puerto en serie del PC
diferente o elija la opciéon Auto Detect (Deteccidon
automatica).

Unable to communicate with the device. Please ensure
you've attached and selected the correct device, check
the cable connection, device battery and status, and try
again. (No es posible establecer la comunicacién con el
dispositivo. Asegurese de que ha conectado y
seleccionado el dispositivo correcto, compruebe la
conexion del cable y la bateria y el estado del
dispositivo e inténtelo de nuevo).

Compruebe todos los valores seleccionados para el
dispositivo leido, incluidos el nombre del
dispositivo, el niumero de serie y el tipo de
conexion. Asegurese también de que el dispositivo,
el cable y el PC estan correctamente conectados.
Compruebe que el estado de la bateria y de la
alarma del dispositivo es correcto. Intente leer el
dispositivo de nuevo.

Unexpected response... retrying (n%) (Respuesta
inesperada... intentandolo de nuevo [n%])

Se ha leido un valor inesperado del dispositivo. El
programa reintentard la comunicacion hasta que
usted cancele la operacién o se establezca la
comunicacion.
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Error

Explicacion

The link device was found, but the device (<serial #>) is
not responding. Please verify the device’s serial
number, place the device closer to the link device to
minimize signal interference, check device battery and
status. (Se ha encontrado el dispositivo de Link pero el
(<N.° de serie>) no responde. Compruebe el nimero de
serie del dispositivo, aproxime el dispositivo al
dispositivo Link para reducir al minimo la interferencia
de sefal y compruebe la bateria y el estado del
dispositivo).

Compruebe que se ha introducido el nimero de
serie correcto. Si no es asi, vuelva a introducir el
numero de serie correcto. Si el nimero de serie es
correcto, intente acercar el dispositivo de Link al
dispositivo de comunicacion. Separe el dispositivo
Link y el dispositivo de comunicacién de posibles
interferencias (como por ejemplo, otros dispositivos
de radiofrecuencia). Compruebe la potencia de la
bateria del dispositivo y si carga una bomba de
insulina, compruebe el estado de suministro de la
bomba.

This pump is delivering a temp basal. Please cancel the
temp basal or wait until it completes, and then try
again. (Esta bomba estd administrando un basal
temporal. Cancele el basal temporal o espere a que éste
finalice y, a continuacion, inténtelo de nuevo).

La bomba que esta intentando leer esta
administrando un basal temporal. Espere a que
finalice el basal temporal para leer la bomba o
cancele el basal temporal y, a continuacion, lea la
bomba.

This device has active errors or alarms. Please clear the
alarms and try again. (Esta bomba tiene alarmas o
errores activos. Resuelva las alarmas e inténtelo de
nuevo).

Hay alarmas activas en la bomba que impiden su
lectura. Lea las instrucciones de la alarma para
resolverla. Resuelva la alarma e intente leer la
bomba de nuevo.

This pump is delivering a bolus. Please cancel the bolus
or wait until it completes, and then try again. (Esta
bomba estd administrando un bolus. Cancele el bolus o
espere a que éste finalice y, a continuacion, inténtelo de
nuevo).

La bomba que esta intentando leer esta
administrando un bolus. Espere a que finalice el
bolus para leer la bomba o cancele el bolus y, a
continuacion, lea la bomba.

The device returned invalid entries; all data read will be
discarded. (El dispositivo ha devuelto entradas no
validas; se desecharan todos los datos leidos).

Péngase en contacto con su representante local
(consulte Asistencia técnica en la pdgina 2).

Errores en la creacion de informes

Muiltiples entradas de datos para la misma fecha

Si existen varias entradas de datos para la misma fecha y hora para el mismo dispositivo, el

programa considera que se trata de un conflicto que no puede resolver. Los informes creados

utilizando los datos de este dispositivo omitiran la parte coincidente de los datos.

Puede intentar ajustar el periodo del informe para omitir los datos coincidentes. O puede

borrar el dispositivo del programa y anadirlo de nuevo para borrar las lecturas previas.

El programa va a ignorar datos

Si se ha modificado la hora de un dispositivo y esto ha causado coincidencias o vacios en los

datos de tres horas o mas, el programa no incluird esa parte de los datos al crear informes.

Errores en tareas de copia de seguridad y restauracion

No puede bloquearse la base de datos

Esto significa que esta utilizando el programa en un entorno multiusuario y que otros usuarios
estan conectados. El programa no permitira realizar una copia de seguridad de la base de

datos mientras otros usuarios puedan estar realizando tareas que podrian afectar a la base de
datos. Una vez que todos los demas usuarios hayan salido de CareLink Pro, podra realizar la

copia de seguridad de la base de datos.
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No puede finalizar una copia de seguridad o una restauracion de la base de datos

Otros usuarios no pueden conectarse y la copia de seguridad o restauraciéon no puede

finalizar. Pbngase en contacto con su representante local (consulte Asistencia técnica en la

pdgina 2).

Fallo en la restauracion de la base de datos

El archivo de copia de seguridad de la base de datos que estd intentando utilizar para el

proceso de restauracién esta dafado. Intente realizar la restauracidon con un archivo de copia

de seguridad diferente.

Desinstalacion del software

Si necesita desinstalar el programa CareLink Pro, siga los pasos indicados a continuacién:

1
2

Abra el Panel de control a través del menu Inicio de Windows.

Seleccione Agregar o quitar programas. Se mostrara la ventana Agregar o quitar

programas.
Desplacese hasta Medtronic CareLink Pro y haga clic en él.
Haga clic en Eliminar. Aparecera el asistente Install Shield.

Haga clic en Siguiente. Aparecerd un mensaje pidiéndole que confirme que desea borrar la
aplicacion.

Haga clic en Si. Se ejecutard el programa de desinstalacién que borrard del ordenador el
programa y todos sus archivos. Cuando haya finalizado, aparecerd un mensaje en la pantalla
del asistente para confirmar la desinstalacién.

Haga clic en Finalizar.

CareLink Pro Guia del usuario  Resolucién de problemas 57



Tabla de iconos

En la siguiente tabla se presentan los iconos y simbolos que aparecen en las etiquetas del

envase y en el equipo:

Uno por contenedor/envase

Atencién: Lea todas las advertencias y precauciones en ﬁ
las instrucciones de uso.

Numero de catadlogo REF
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Datos de los archivos CSV

Cuando exporte datos de informes del programa CarelLink Pro, se exportan en un archivo .csv.

Este archivo se puede importar en una aplicacién de hoja de cdlculo, como Microsoft Excel.

Consulte las definiciones de la columna de archivo CSV para ver una lista completa de los

datos que un archivo CSV puede contener.

El archivo CSV contiene el nombre y la ID de paciente, el periodo de informe, e identifica cada

dispositivo incluido en el informe.

Definiciones de los datos de las columnas

Orden en que se registraron los datos en el
dispositivo.

Index (Indice)

Time (hora)

BG Reading (mg/dL or mmol/L) (valor de GS [mg/dL o
mmol/L])

Basal Rate (U/h) (indice basal [U/h])

Temp Basal Type (tipo de basal temporal)

Hora en que se registraron los datos en el
dispositivo.

Valor de glucosa en sangre registrado por el
medidor, Guardian o la bomba. Si los datos proceden
de una bomba o Guardian, esta columna refleja los
valores de GS por puncion digital y los valores de GS
recibidos del medidor Link.

Indice basal activo de administracién de insulina en
unidades por hora.

El tipo de ajuste de los basales temporales (indice de
insulina o porcentaje del basal).
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Bolus Type (tipo de bolus)

Bolus Volume Delivered (U) (volumen del bolus
administrado [U])

Prime Type (tipo de cebado)

Alarm (alarma)

Rewind (rebobinar)

BWZ Target High BG (mg/dL or mmol/L) (limite
superior del objetivo de GS con Bolus Wizard [mg/dL o
mmol/L])

BWZ Carb Ratio (ratio de carbohidratos con Bolus
Wizard)

BWZ Carb Input (entrada de carbohidratos en Bolus
Wizard)

BWZ Correction Estimate (U) (estimacion para
correccion con Bolus Wizard [U])

Tipo de bolus de insulina administrado (normal,
cuadrado, dual [parte normal] o dual [parte
cuadradal).

Numero de unidades de insulina administradas

realmente durante el bolus de insulina.

Manual o fijo. El cebado manual se utiliza justo
después de un rebobinado para llenar de insulina el
tubo del equipo de infusion antes de insertarlo. El
cebado fijo se utiliza después de la insercion del
equipo de infusién para llenar la canula blanda con
insulina después de retirar la aguja introductora.

Nombre de la alarma generada.

La fecha y la hora en que el dispositivo fue
rebobinado.

Valor para el limite superior del intervalo del objetivo
de glucosa en sangre utilizado por la funcién Bolus
Wizard.

Valor para la relacion insulina/carbohidratos. Si se
utilizan los gramos como unidad, el ratio es el
numero de gramos cubiertos por una unidad de
insulina. Si se utilizan las raciones para las unidades,
el ratio es el nimero de unidades de insulina
utilizadas para cubrir una racién.

Cantidad de carbohidratos introducida en el Bolus
Wizard y utilizada para estimar un bolus.

Unidades del bolus de insulina que hay que
administrar para corregir el nivel de glucosa en
sangre, calculadas por medio del Bolus Wizard.
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Cantidad de insulina activa que se calcula que

BWZ Active Insulin (U) (insulina activa con Bolus quedard en el cuerpo de administraciones previas de
Wizard [U]) bolus de insulina al determinar la cantidad de bolus
estimada con la funcién Bolus Wizard.

Sensor Calibration BG (mg/dL or mmol/L) (GS para Valor de GS utilizado para calibrar el sensor, en
calibracion del sensor [mg/dL o mmol/L]) mg/dL o mmol/L.

Sensor Glucose (mg/dL or mmol/L) (glucosa del sensor

[mg/dL o mmol/L]) Valor de glucosa del sensor.

Senales de entrada (ISIG), leidas por el sensor,

Sl s el LSC) medidas en nanoamperios (nA).

Mas informacion sobre los archivos CSV exportados por CareLink
Pro

El titulo mostrado en la parte superior del archivo CSV incluye la siguiente informacion:
«  nombre del paciente

« lista de dispositivos seleccionados y sus numeros de serie

« intervalo de fechas seleccionado

Cada bloque de columnas tiene un titulo que incluye la siguiente informacién:

«  nombre del dispositivo al que corresponde el bloque de datos

« numero de serie de ese dispositivo

Si los datos no aparecen tal como se prevé

Existen diferentes factores que pueden provocar que los datos del archivo CSV se presenten
de manera distinta a la esperada.

«  Los cambios en la fecha o la hora del dispositivo pueden modificar la secuencia o hacer que
los registros queden fuera del intervalo de fechas seleccionado para mostrar.

«  Si existe un vacio grande entre las lecturas del dispositivo, es posible que los datos de dicho
dispositivo se presenten en varios bloques.
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Glosario

A1C - Hemoglobina glucosilada.

Advertencia de reservorio bajo - Aviso programable que le informa con una alerta cuando queda
un numero especificado de unidades en el reservorio o cuando resta una cantidad de tiempo
especifica para que el reservorio quede vacio.

Areabajolacurva (AUC)-Indicala cantidad de las desviaciones superiores e inferiores segtin valores
predefinidos. Los datos de desviacionesindican lafrecuencia de valores altos y bajos. El AUCindica
la magnitud de los eventos al mostrar el grado y la duracién de la desviacion.

Aviso de calibracion - La bomba emitira una alarma "Medir GS a HH:MM" automéaticamente cada 12
horas, indicando que el valor de calibracién actual ya no es valido. El valor del aviso de calibracién
es el tiempo de antelacion antes de que el valor de calibracién actual caduque con que el usuario
desea que se le recuerde la calibracién. Por ejemplo, si la opcidn de aviso de calibracion esta
configurada en 2 horas, la alarma "Medir GS a HH:MM" se activard 2 horas antes de que se necesite
la calibracion.

Basal temporal (basal temp) - Insulina basal temporal Unica con una cantidad y una duracion
especificas. Se utiliza para apoyar las necesidades de insulina durante actividades o situaciones
especiales que no forman parte de la rutina diaria normal.

Bolus corrector - Cantidad de insulina necesaria para devolver un nivel alto de glucosa en sangre a
un valor dentro del intervalo del objetivo de glucosa en sangre.

Bolus de comida - Dosis de insulina administrada para cubrir la elevacion esperada de la glucosa en
sangre que se produce después de una comida.

Bolus de insulina - Dosis de insulina administrada para cubrir una elevacién esperada de la glucosa
en sangre (como la elevacién que tiene lugar después de una comida o un tentempié) o para
reducir un nivel alto de glucosa en sangre hasta el intervalo del objetivo de glucosa en sangre.

Bolus Dual Wave® (bolus dual) - Combinacién de un bolus normal que se administra
inmediatamente, sequido de un bolus de onda cuadrada. La parte de onda cuadrada se administra
de manera uniforme durante cierto periodo de tiempo.

Bolus Express - Método de administracion de cualquier tipo de bolus mediante el botén Bolus
Express de la bomba.

Bolus manual - Elemento opcional disponible en el BOLUS MENU (Menu Bolus) cuando la funcién
Bolus Wizard esta activado. Método de programacion de un bolus sin la funcion Bolus Wizard.

Bolus maximo - Cantidad maxima de bolus de insulina que la bomba administrara de una sola vez.
(Definido por el usuario).

Bolus normal - Administracion inmediata de una cantidad de unidades de insulina especifica.

Bolus Square Wave® (bolus cuadrado) - Bolus administrado de manera uniforme durante un
periodo de tiempo especificado (entre 30 minutos y 8 horas).
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CareLink’ Personal - Servicio en linea que permite administrar los datos de diabetes a través de
Internet.

CH - Carbohidratos.

ComLink - Dispositivo transceptor de radiofrecuencia (RF) que se utiliza para descargar los datos de
las bombas Paradigm en el ordenador.

Com-Station - Dispositivo que se utiliza para descargar los datos de la bomba MiniMed 508 y de
medidores de otros fabricantes en el ordenador.

Concentracion de insulina - Concentracion o tipo de insulina que el médico ha recetado al usuario.
Afecta a la velocidad con la que la bomba administra la insulina. Si cambia la concentracion de
insulina del usuario, deben volver a programarse los patrones basales y los indices basal maximo
y de bolus.

Easy Bolus™ - Método de infusion para un bolus normal utilizando el botén Easy Bolus de la bomba.

Equipo de infusion - Aparato utilizado para insertar y fijar una canula bajo la piel y transportar la
insulina hasta el punto de insercién a través de un tubo desde la bomba.

Factor de bolus corrector - Cuanto rebajaran 1,0 unidades de insulina el nivel de glucosa en sangre.
Este factor se utiliza para calcular la cantidad del bolus corrector cuando la glucosa en sangre esta
alta. (Nivel GS) - (Objetivo GS) = X. X + (factor del bolus corrector) = cantidad del bolus corrector

Funcién Patrones - Funcion ampliada de la bomba que le permite programar basales opcionales
(Patron A, Patrén B) que apoyan actividades que no forman parte de su rutina diaria pero que son
habituales en su estilo de vida. Tales actividades podrian ser la practica de un deporte una vez por
semana, un cambio en sus habitos de suefio durante el fin de semana o cambios hormonales
durante el ciclo menstrual.

Glucosa alta - La bomba generara una alarma si el sensor indica que el valor de glucosa del sensor
es igual o superior a este valor. Tiene la opcién de activar o desactivar esta funcion.

Glucosa baja - La bomba generard una alarma si el sensor indica que el valor de glucosa del sensor
es igual o inferior a este valor. Tiene la opcién de activar o desactivar esta funcion.

GS - Abreviacidn de glucosa en sangre
HbA1c - Hemoglobina glucosilada.

Hiperglucemia - Elevacién de la glucosa en sangre detectada al controlar los niveles de glucosa en
sangre, con o sinalguno delos siguientes sintomas o todos ellos: nduseas, vomitos, visién borrosa,
cefalea, molestias gastricas, miccion frecuente de grandes cantidades de orina y letargo.

Hipoglucemia - Disminucion de la glucosa en sangre detectada al controlar los niveles de glucosa
en sangre, con o sin alguno de los siguientes sintomas o todos ellos: hambre excesiva, agitacion
o temblores, sudoracidn, vision borrosa, mareo, cefalea, lenguaje farfullante, cambios subitos del
estado de animo o cambios de la personalidad.

ID transm - NUmero de serie del transmisor que se esta utilizando actualmente.

Incremento de insulina - Medicion de insulina que puede ajustar y utilizar para la administracién
de un Easy Bolus.

indice basal - Ajuste de la bomba que proporciona una infusién continua de insulina para mantener
el nivel de glucosa en sangre estable entre las comidas y durante la noche. La insulina basal
reproduce la liberacién de insulina pancreatica, que cubre todas las necesidades de insulina no
relacionadas con las comidas.

Insulina basal - Infusidn continua por horas de insulina administrada automaticamente por una
bomba de insulina segun perfiles preprogramados e indices personalizados definidos en la
bomba. La bomba administra una infusion diaria de insulina que generalmente cubre las
necesidades "basales" de insulina durante los periodos de ayuno (por ejemplo, por la noche y
entre comidas).

Insulina basal maxima - Cantidad maxima de insulina basal que la bomba administrara de una sola
vez. (Definido por el usuario).

ISIG - Valores del sensor que indican si los componentes electrénicos del transmisor de un sistema
realzado con un sensor funcionan correctamente. Si el valor del pardmetro ISIG es inferior a 24,00
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nA o superior a 29,00 nA, solicite asistencia técnica sobre el producto. Es posible que sea necesario
sustituir el transmisor.

Medidor - Dispositivo médico para determinar la concentracién aproximada de glucosa en la sangre.
Se coloca una pequeia gota de sangre en una tira de analisis desechable, que el medidor lee y
utiliza para calcular el nivel de glucosa en sangre. A continuacién, el medidor muestra el nivel en
mg/dL o mmol/L.

Opcion del medidor - Funcién que permite que la bomba reciba lecturas de glucosa procedentes
de un medidor de glucemia vinculado.

Parte cuadrada - (Cuad) La segunda parte de un bolus dual. La parte cuadrada se administra de
manera uniforme durante un periodo de tiempo después de la parte AHORA.

Patron estandar - El patron basal normal que soporta su actividad diaria normal. Cuando la funcién
Patrones esta desactivada, la bomba utiliza su patrén estandar (basal).

Patrones basales-El usuario puede programarun maximo de tres patrones de indice basal diferentes
en la bomba para la administracion de insulina basal: Estandar, Patron A y Patrén B. Para cada
patron existe la opcion de configurar un maximo de 48 indices basales.

Perfil basal - indice basal con una hora inicial y final. El usuario puede programar varios perfiles
diferentes en la bomba, cada uno con un indice basal diferente, durante un periodo de 24 horas
para conseguir un mejor control de la glucosa.

Porcentaje de diferencia absoluta media (%DAM) - Representa el nivel de precisién de la
calibracién del sensor con respecto a las lecturas del medidor de glucosa en sangre. Cuanto menor
sea este nimero, mayor serd la precision de la calibracion. El %DAM se calcula tomando la
diferencia entre pares proximos de lecturas de glucosa del sensor y del medidor de glucosa en
sangre, dividiéndola por la lectura del medidor de glucosa en sangre y después calculando el
promedio de todos los pares.

Prueba de A1C - Prueba de hemoglobina A1C que se utiliza para interpretar el nivel de glucosa en
sangre durante un periodo de tiempo.

Prueba de cuerpos ceténicos - Los cuerpos cetdnicos son productos de desecho que se generan
cuando el organismo se ve obligado a quemar grasas corporales en lugar de glucosa para obtener
energia. Puede ser un signo de falta de insulina en el organismo. La prueba de cuerpos ceténicos
mide la cantidad de cuerpos cetdnicos concentrados en la sangre o la orina.

PruebadeHbA1c-Pruebade hemoglobina A1C que se utiliza parainterpretar el control de laglucosa
en sangre o la media de los niveles durante un periodo de tiempo de 2 a 3 meses.

Ratio de CH (ratio de carbohidratos) - La cantidad de carbohidratos cubiertos por una unidad de
insulina. (Véase también Ratio de raciones).

Ratio de raciones-Cantidad de insulina necesaria para cubrir una (1) racién de carbohidratos. (Véase
también Ratio de CH).

RF - Radiofrecuencia (RF).

Sensibilidad a la insulina - Cantidad de mg/dL (o mmol/L) en que se reduce el nivel de glucosa en
sangre (GS) por unidad de insulina. (Datos de la funcién Bolus Wizard).

Sonido de bolus - La bomba puede programarse para que el usuario oiga un pitido cuando
seleccione una cantidad de bolus de insulina (0,5 6 1,0 unidades) para administrar. Es Util para
situaciones en las que resulte dificil ver los botones de la bomba.

Suspender - Funcién de la bomba que detiene todas las administraciones de insulina. Se cancela
toda administracién de bolus y/o cebado en curso. La administracién basal queda en pausa hasta
su reanudacion.

Temp - Temporal.
Transferencia - Proceso de envio de datos de la bomba o medidor al programa CareLink® Personal.

Unidades de carbohidratos - La entrada de una comida cuando se utiliza la funcion Bolus Wizard.
Se introduce en gramos (de carbohidratos) o raciones.

Vincular
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(1) Activar y configurar la opcién del medidor que permite que la bomba reciba lecturas de GS
desde un medidor que se comunica con la bomba.

(2) También se utiliza en este programa para hacer referencia a los vinculos de hipertexto. Cuando
se hace clicen ellos, los vinculos de hipertexto llevan a otro lugar del programa o a otro sitio web.
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